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NOTICES

This GTSTRUDL® Release Guide is applicable to Version 32, with a release date in the
GTSTRUDL title block of June 2012.

The GTSTRUDL® computer program is proprietary to, and a trade secret of the Georgia
Tech Research Corporation, Atlanta, Georgia, U.S.A.

DISCLAIMER

NEITHER GEORGIA TECH RESEARCH CORPORATION NOR GEORGIA INSTITUTE
OF TECHNOLOGY MAKE ANY WARRANTY EXPRESSED OR IMPLIED AS TO THE
DOCUMENTATION, FUNCTION, OR PERFORMANCE OF THE PROGRAM
DESCRIBED HEREIN, AND THE USER OF THE PROGRAM IS EXPECTED TO MAKE
THE FINAL EVALUATION AS TO THE USEFULNESS OF THE PROGRAM IN THEIR
OWN ENVIRONMENT. 

Commercial Software Rights Legend

Any use, duplication, or disclosure of this software by or for the U.S. Government shall be
restricted to the terms of a license agreement in accordance with the clause at DFARS
227.7202-3 (June 2005).

This material may be reproduced by or for the U.S. Government pursuant to the copyright
license under the clause at DFARS 252.227-7013, September 1989.

© Copyright 2012
Georgia Tech Research Corporation

Atlanta, Georgia  30332-0355
U.S.A.

ALL RIGHTS RESERVED

GTSTRUDL® is a registered service mark of the Georgia Tech Research Corporation,
Atlanta, Georgia USA.

Windows 7®, Windows Vista®, Windows XP®  and Windows 2000® are registered
trademarks of Microsoft Corporation in the United States and/or other countries.

Intel® CoreTM2 Duo and  Intel® CoreTM2 Quad are registered trademarks of Intel
Corporation in the United States and other countries.
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Chapter 1

Introduction

Version 32 covers GTSTRUDL operating on PC’s under the Windows 7, Windows
Vista and Windows XP operating systems.  Chapter 2 presents the new features and
enhancements which have been added since the release of Version 31.  Chapter 3 provides
you with details regarding error corrections that have been made since the Version 31 release.
Chapter 4 describes known problems with Version 32.  Chapter 5 describes prerelease
features -- new features which have been developed and subjected to limited testing, or
features for which the user documentation has not been added to the GTSTRUDL User
Reference Manual.  The command formats and functionality of the prerelease features may
change before they become supported features based on additional testing and feedback from
users.  

The Prerelease features are subdivided into Design, Analysis, and General categories.  The
features in these categories and their sections numbers in Chapter 5 are shown below:

5.2  Design Prerelease Features

5.2.1 LRFD3 Steel Design Code.  Rather than use the LRFD3 code which
is a prerelease feature, users should use the AISC13 code which is
now a released feature.

5.2.2 ACI Concrete Code 318-99.  Rather than use the 318-99 code which
is a prerelease feature, users should use the 318-05 code which is now
a released feature.

5.2.3 Rectangular and Circular Concrete Cross Section Tables

5.2.4 Design of Flat Plates Based on the Results of Finite Element Analysis
(The DESIGN SLAB Command)

5.2.5 ISO 19902:2007(E) code for fixed steel offshore structures.

5.2.6 ASCE4805 Steel Design Code.  This code is for the ultimate strength
design of steel transmission pole structures.

5.3 Analysis Prerelease Features

5.3.1 Calculate Error Estimate Command
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5.4 General Prerelease Features

5.4.1 Rotate Load Command

5.4.2 Reference Coordinate System Command

5.4.3 GTMenu Point Coordinates and Line Incidences Commands

We encourage you to experiment with these prerelease features and provide us with
suggestions to improve these features as well as other GTSTRUDL capabilities.
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Chapter 2

New Features in Version 32

This chapter provides you with details regarding new features and enhancements that have
been added to many of the functional areas of GTSTRUDL in Version 32.   This release guide is also
available online upon execution of GTSTRUDL under Help - Reference Documentation - GT
STRUDL  Release Guide.  

2.1 DBX

1. WRITE CODE CHECK RESULTS has been added.  This DBX file contains the same data
as found in the output from LIST CODE CHECK RESULTS.  ASCII80 and BINARY
sequential formats are supported.

Syntax:

WRITE CODE (CHECK) (RESULTS) (MEMBERS list)

Examples:

WRITE CODE ALL MEMBERS
WRITE CODE RES MEMBERS EXISTING 1 TO 1000

Documentation:

“Section 2.1.14.4.3 The LIST CODE CHECK RESULTS Command”, Volume 1,
GTSTRUDL Reference Manual.
“Summary of DBX Commands,” “The WRITE Command,” Volume 5, GTSTRUDL
Reference Manual.  “Table 1-30,” Volume 5, GTSTRUDL Reference Manual.

2. The WRITE CABLE FORCES command has been added to the DBX feature.  This DBX
file contains the normal stress, the corresponding normal force, and the three global element
nodal reaction components at each of the two to six cable element nodes for all active static
loading conditions, computed from the latest nonlinear analysis. All documented file formats
and access modes are supported.
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Syntax:

WRITE CABLE FORCES (MEMBERS list)

Example:

WRITE CABLE FORCES ALL MEMBERS

WRITE CABLE FORCES MEMBERS EXISTING 1 TO 1000

Note that only the cable elements among the specified list of members are processed.

Documentation:

“Summary of DBX Commands.”  ”The WRITE Command," Volume 5, GTSTRUDL
Reference Manual.  “Table 1-31,” Volume 5, GTSTRUDL Reference Manual.

2.2 Dynamics

1. The GT64MLANCZOS eigenvalue analysis solution method has been implemented,
extending high-performance sparse-equation eigenvalue analysis to 64-bit computer
platforms.  GT64MLANCZOS is the most powerful version of the GTLANCZOS family of
eigenvalue analysis solution methods (GTLANCZOS, GTSELANCZOS, and now
GT64MLANCZOS) presently available in GTSTRUDL and incorporates the following
features:

1) The Lanczos iteration process employs an in-core, single processor version of the
GT64M sparse equation solver.  Multiple processors and out-of-core processing are
not available as of this initial implementation for Version 32.

2) All computations associated with the Lanczos  iteration process take advantage of
64-bit addressing on 64-bit platforms, greatly increasing the number of degrees of
freedom that can be treated and the number of modes that can be computed when
compared to the GTLANCZOS and GTSELANCZOS methods. 

The GT64MLANCZOS method is activated when the GT64M option is specified by the
ACTIVE SOLVER command:

ACTIVE SOLVER GT64M
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or when the GT64MLANCZOS method is specified in the EIGENSOLUTION
PARAMETERS command:

EIGENSOLUTION PARAMETERS
SOLVE USING GT64MLANCZOS

.

.

.
END

Note that the GT64M solver suite is a premium feature and requires a separate fee, license,
and password. 

Documentation

Section 2.1.13, Volume 1, “The ACTIVE SOLVER Command”
Section 2.4.5.2, Volume 3, “Eigenproblem Solution Specifications”

2. Improvements are made to the consistency checking of the time point data for the execution
of modal integration and direct integration time history analyses.  If the number of time
points to be processed by these analyses exceeds the maximum allowable 4,000,000, the
following error message is now given and the indicated action taken:

 **** ERROR_STTINT -- Maximum allowable number of integration time points
                         (4 million) exceeded for loading 1002    .

   Scan mode entered and analysis terminated.

Documentation:

Section 2.4.5.4, Volume 3, “The DYNAMIC ANALYSIS Command”
Section 2.4.5.5.6, Volume 3, “Mode Superposition Analysis”
Section 2.4.5.5.7, Volume 3, “Transient Analysis”
Section 2.4.5.5.8, Volume 3, “Direction Integration (PHYSICAL) Analysis”

3. The COMPUTE MODAL DAMPING RATIO AVERAGE BY ELEMENT command has
been enhanced such that a contribution to the composite modal damping ratios are now
computed for viscous damper elements.

Documentation:

Section 2.4.3.4, Volume 3, “Specification of Damping Properties”
Section 2.4.3.7, Volume 3, “The Viscous Damper Element for Linear and Nonlinear         

                                  Dynamic Analysis”
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2.3 Finite Elements

1. A new 8 node solid element called the IPSLIM has been implemented.  This new element
has the same node ordering as the IPSL and IPLS elements.  This new element is more
flexible than the IPSL and IPLS elements and will converge faster.  A comparison of the
results for the example of a cantilever beam presented in Section 2.3.9.3 of Volume 3 of the
User Reference Manual is shown below:

ELEMENT    MESH     SXX STRESS (ksi)     MAXIMUM DISPLACEMENT(in)
      x = 9",y = 0", z = 2" x = 21", y = 2", z = 2"

IPLS B-1 2.280 0.0552
B-2 2.448 0.0597

IPQS B-1 2.492 0.0613

IPSL B-2 2.448 0.0597

IPSLIM B-1 2.499 0.0613
B-2 2.500 0.0613

IPSQ B-2 2.500 0.0612

THEORETICAL  (30) 2.500 0.0612

The IPSLIM element not only converges faster than the IPSL and IPLS but produces almost
the same results for the same number of elements as the twenty-noded IPSQ and IPQS
elements.

2. Three new four node elements have been implemented.  A new plane stress called the
Q6CDRL  and a new plate bending element called the PBMITC have been implemented.
These elements were combined to form a new four node flat plate element called the
SBMITC which has six degrees-of-freedom per node. 

The Q6CDRL is an isoparametric four node element based on a variational formulation. This
formulation provides a rotational degree of freedom about the planar z-axis (commonly
referred to as the drilling degree of freedom). This drilling degree of freedom is very useful
for interaction with plane frame elements. In addition, incompatible modes with a correction
method were implemented in order to avoid shear locking. The Q6CDRL successfully
addresses all other common issues of plane stress elements, such as spurious modes, failure
to pass the patch test and geometric invariance.
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The PBMITC element is based on the well known MITC4 element (mixed interpolation of
tensorial components). It is an isoparametric four node plate bending element based on
Mindlin’s plate theory, which includes transverse shear strains (applicable for moderately
thick plates). This element does not exhibit any of the common thick plate bending issues
such as shear locking and spurious modes.

By combining the Q6CDRL and PBMITC (uncoupled in-plane and out-of-plane behavior),
a versatile four node isoparametric flat plate element (SBMITC) is now available for general
use in shell and plate problems.

2.4 General

1. PRINT MEMBER LENGTH SORTED LIMIT v now prints the total number of members
that meet the specified limit after the list of member lengths.

This only applies to LIMITS with decimal numbers, which indicates a length value and
where the number of members meeting the criterium is unknown, and not to LIMITS
with an integer number, which indicates a specified number of member lengths to print.

Example:

 { 4367} > UNITS CM
 { 4368} > PRINT MEMBER LENGTH SORTED LIMIT 20.0

(output omitted)

 **** INFO_PRTMBL - Found   10 members <     20.000

Documentation:

“Section 2.1.14.2.1 PRINT MEMBER LENGTH SORTED”, Volume 1, GTSTRUDL
Reference Manual.

2. A new option has been added to the PRINT command, PRINT MEMBER BETA
ANGLES, which allows you to print only BETA angles, without the other
CONSTANTS.

Syntax:

PRINT MEMBER BETA ANGLES NONZERO ONLY (TOLERANCE v

INDIVIDUALLY
GROUPED (TOLERANCE v )

DEGREES
RADIANS

COMMAND FORMAT MEMBERS list

1

2

( ) ( ( ) ))

( )

( ( )) ( )

−

→⎧
⎨
⎩

⎫
⎬
⎭

⎧
⎨
⎩

⎫
⎬
⎭

−
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Examples:

PRINT MEMBER BETA ANGLES NONZERO ONLY TOLERANCE 0.1 DEGREES
PRINT MEMBER BETA GROUPED COMMAND FORMAT

Documentation:

Section 2.1.14.2.3 PRINT MEMBER BETA ANGLES, Volume 1, GTSTRUDL
Reference Manual

3. A GLOBAL option has been added to LIST FORCES. This option will print member
forces in the global reference frame, instead of the standard local (member) reference
frame.

Syntax:

LIST FORCES (GLOBAL)

Example:

LIST FORCES GLOBAL MEMBERS 1 TO 10

Documentation:

Section 2.1.14.4, Static Analysis Computed Results - LIST Command, Volume 1,
GTSTRUDL Reference Manual.

4. Two new options have been added to the LIST JOINT FORCES command, GLOBAL
(WITH TOTAL) and MEMBERS m_list.  

The GLOBAL option causes the member and element forces to be rotated from the local
coordinate system to the global coordinate system, and in the case of members with
ECCENTRICITIES, transformed from the flexible end of the member to the joint -
therefore LIST JOINT FORCES GLOBAL will not match LIST FORCES even after
resolving the coordinate systems for members with ECCENTRICITIES. The WITH
TOTAL option will print the summation of all listed members and elements for each
DOF for each joint and active load. The GLOBAL option always outputs all 6 global
DOF, instead of being restricted to member DOF.

The MEMBERS m_list option restricts the printed forces to members or elements in
m_list and any joint that no member in m_list is incident to will have an informative
message printed indicating this condition (“No members or elements in the specified list
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are attached to this joint.”), so it is suggested that the MEMBERS m_list option only be
used in conjunction with JOINT list, instead of the ALL JOINTS default, to avoid a large
number of these informative messages.

Syntax:

LIST  JOINT FORCES
LOCAL

  GLOBAL (WITH) (TOTAL) -

 
ALL (JOINTS)

 JOINTS list
 (MEMBERS m_ list)

→⎧
⎨
⎩

⎫
⎬
⎭

→⎧
⎨
⎩

⎫
⎬
⎭

Examples:

 {  188} > OUTPUT FIELD F
 {  189} > OUTPUT DECIMAL 3
 {  190} > LIST JOINT FORCES JOINT 3

----------------------------------------------------------------------------------------------------------------------------------
-
 ---    LOADING - 1       

----------------------------------------------------------------------------------------------------------------------------------
-

      RESULTANT JOINT FORCES OUTPUT BY LOADING

           MEMBER/    REF

/-JOINT-/-ELEMENT-/-FRAME-/---------------------FORCES---------------------/---------------------MOMENTS-------------------/--ECC-
/
                                FORCE X         FORCE Y         FORCE Z         MOMENT X         MOMENT Y         MOMENT Z

 3        1          LOCAL            6.148          -6.119           0.000           0.000           0.000          11.185   NO
 3        2          LOCAL            6.148          -6.119           0.000           0.000           0.000         -11.185   NO
 3        3          LOCAL           -6.119          -6.148           0.000           0.000           0.000          11.476   NO
 3        4          LOCAL           -6.119          -6.148           0.000           0.000           0.000         -11.476   NO

 {  191} > LIST JOINT FORCES GLOBAL JOINT 3

----------------------------------------------------------------------------------------------------------------------------------
-
 ---    Loading - 1       

----------------------------------------------------------------------------------------------------------------------------------
-
      GLOBAL joint forces output by loading

           MEMBER/    REF

/-JOINT-/-ELEMENT-/-FRAME-/---------------------FORCES---------------------/---------------------MOMENTS-------------------/--ECC-
/
                                FORCE X         FORCE Y         FORCE Z         MOMENT X         MOMENT Y         MOMENT Z

 3        1         GLOBAL            6.119           6.148           0.000           0.000           0.000          11.185   NO
 3        2         GLOBAL            6.119           6.148           0.000           0.000           0.000         -11.185   NO
 3        3         GLOBAL           -6.119          -6.148           0.000           0.000           0.000          11.476   NO
 3        4         GLOBAL           -6.119          -6.148           0.000           0.000           0.000         -11.476   NO

 {  192} > LIST JOINT FORCES GLOBAL WITH TOTAL JOINT 3

----------------------------------------------------------------------------------------------------------------------------------
-
 ---    Loading - 1       

----------------------------------------------------------------------------------------------------------------------------------
-
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      GLOBAL joint forces output by loading

           MEMBER/    REF

/-JOINT-/-ELEMENT-/-FRAME-/---------------------FORCES---------------------/---------------------MOMENTS-------------------/--ECC-
/
                                FORCE X         FORCE Y         FORCE Z         MOMENT X         MOMENT Y         MOMENT Z

 3        1         GLOBAL            6.119           6.148           0.000           0.000           0.000          11.185   NO
 3        2         GLOBAL            6.119           6.148           0.000           0.000           0.000         -11.185   NO
 3        3         GLOBAL           -6.119          -6.148           0.000           0.000           0.000          11.476   NO
 3        4         GLOBAL           -6.119          -6.148           0.000           0.000           0.000         -11.476   NO
                            --------------- --------------- --------------- --------------- --------------- ---------------
                    Totals            0.000           0.000           0.000           0.000           0.000           0.000     

 {  193} > LIST JOINT FORCES GLOBAL WITH TOTAL JOINT 3 MEMBERS 1 2

----------------------------------------------------------------------------------------------------------------------------------
-
 ---    Loading - 1       

----------------------------------------------------------------------------------------------------------------------------------
-
      GLOBAL joint forces output by loading

           MEMBER/    REF

/-JOINT-/-ELEMENT-/-FRAME-/---------------------FORCES---------------------/---------------------MOMENTS-------------------/--ECC-
/
                                FORCE X         FORCE Y         FORCE Z         MOMENT X         MOMENT Y         MOMENT Z

 3        1         GLOBAL            6.119           6.148           0.000           0.000           0.000          11.185   NO
 3        2         GLOBAL            6.119           6.148           0.000           0.000           0.000         -11.185   NO
                            --------------- --------------- --------------- --------------- --------------- ---------------
                    Totals           12.237          12.295           0.000           0.000           0.000           0.000     

Documentation:

Section 2.1.14.4, Static Analysis Computed Results - LIST Command, Volume 1,
GTSTRUDL Reference Manual.

5. Modest efficiency and performance improvements have been made to the GTSES
stiffness analysis solver.  However, the solver remains a single-processor, 32-bit solver
governed by 32-bit virtual memory allocation and addressing limitations.

Documentation:

Section 2.1.13.2, The STIFFNESS ANALYSIS Command, Volume 1.
Section 2.1.13.3.2, Split Solver Static Analysis Using the GTSES/GT64M Sparse
Equation  Solvers, Volume 1.
Section 2.1.13.4, The ACTIVE SOLVER Command, Volume 1.

6. The RENAME command has been added.  This command allows you to change the name
of an existing component - joint, member/element, load or group.
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Syntax:

RENAME type old_name new_name

where,
type is the type of component to rename.  The allowable types are:

JOINT (or NODE), MEMBER (or ELEMENT), LOAD,
GROUP.

old_name is the current component name.  This name must already exist. 
The name may be either integer or alpha-numeric.

new_name is the new name.  There may not already be a component of
this type with the new name. The new name may be either
integer or alpha-numeric.

Example:

RENAME MEMBER 1 1001

After this command LIST FORCES MEMBER 1 will generate an error message,
but LIST FORCES MEMBER 1001 will work properly.

Documentation:

Section 2.1.12.20, The RENAME Command, Volume 1.

7. The MEMBER PROPERTIES Command has been enhanced giving the user the ability to
define member properties for Channels and Polygonal Tubes by specifying their
dimensions. 

The following are examples of the two new options for the MEMBER PROPERTIES
Command:

 MEMBER PROPERTIES 
1 TO 10 CHANNEL TOTAL DEPTH 16.97  -

WEB THICKNESS 0.585 FLANGE WIDTH 10.425  -
FLANGE THICKNESS 0.985

11 TO 20 POLYGONAL TUBE - 
DIAMETER BETWEEN FLATS 14.35  -
NUMBER OF SIDES 8  -
THICKNESS 0.985
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These new options are available for prismatic and variable members. The PRINT
MEMBER PROPERTIES FOR DESIGN and the PRINT MEMBER PROPERTIES FOR
DESIGN WITH DEFINITIONS commands now print data for these members.
Also, members whose properties have been defined through these options can be code
checked by the GTSTRUDL Codes that support such cross-sections. 

See Section 2.1.9 on Volume 1 of the GTSTRUDL User Reference Manual for more
information.

8. The CALCULATE SOIL SPRINGS command has been enhanced to:

1) Allow a single KS value without an element list, which indicates that GTSTRUDL
should find all elements and element faces that lie on the specified plane and create an
assumed element list.  This makes adding soil springs to an entire slab on one level much
simpler.

2) Added a NO SUPPORT CHECK option to the COMPRESSION ONLY nonlinear
springs capability.  NLS elements will be added to the model without regard to the
current support status of the involved joints as opposed to the current requirement that
soil springs can be added only to joints with the appropriate DOF (FX, FY or FZ)
restrained.  This allows you  greater flexibility in modeling, but leaves the responsibility
of creating a stable analysis model up to you.  An informational message is generated if
the NO SUPPORT CHECK option is used, but the appropriate DOF is fixed - which will
result in the created NLS being nonfunctional:

**** WARNING_SSPR03 - The NO SUPPORT CHECK option will apply nonlinear springs to 
                       joints without regard to support status.  This message is to
                       inform you the following joints have a restrained (fixed) DOF
                       in the specified spring direction and the applied NLS will
                       have no effect on a subsequent analysis unless the DOF is released.

The NO SUPPORT CHECK option cannot be used with the INPLANE option.

3) The name of the generated NLS has been added to the output if the COMPRESSION
ONLY  option is used.  In addition, the informative comments output below the spring
value report now reflect the actual names of the generated NLS so they can be copied
from the output to be added to your input or pasted into the Command window.

Documentation:

Section 2.1.12.13, The CALCULATE SOIL SPRING VALUES Command, Volume 1.

9. A new option, LAUNCH,  has been added to the RUN command.  This option utilizes the
Windows ShellExecuteEx utility to open programs with a specified file, but unlike the
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standard RUN command, you do not need to know the program installation path.  This is
especially useful for running utility programs like Microsoft’s Excel, where the
installation path may be different on various computers.

Syntax:

RUN LAUNCH (WAIT) (PROGRAM)  'program' (FILE ) ‘file’

Elements:

program = For the LAUNCH version, program is the name (e.g. Excel) of
the program to be launched.

file = an input file or other command line options for program, only
available to the LAUNCH version.

Explanation:

LAUNCH
This version of the RUN command uses the Windows “ShellExecuteEx”
functionality to run a program (program above), even though you do not
know where it is installed.  The program must be registered in Windows
such that the “assoc” DOS command can report the program name given
its standard file extension.  For example, if you issue the DOS command
“assoc .gti” you get the response “.gti=GTStrudl.Input”.  The element file
is sent to program as an argument.  The HIDE option is not available for
LAUNCH.  PROGRAM and FILE are optional words and have no effect
on the command operation.  If file is specified as “NULL”, then program
will be launched with no arguments.

WAIT Indicates that GTSTRUDL command processing should stop until
program has completed.  If this option is not used, GTSTRUDL will
continue and process the next command if you are running a macro or an
input file.  Use the WAIT option if the results of program are required for
subsequent GTSTRUDL commands.

Example:

RUN LAUNCH WAIT PROGRAM ‘Excel’ FILE ‘MyData.xls’

This will open Microsoft Excel as if you had double-clicked the file ‘MyData.xls’.
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Documentation:

Section 2.1.12.17 The RUN Command, Volume 1, GTSTRUDL Reference Manual.

10. The CALCULATE SOIL SPRINGS and CALCULATE PRESSURE commands have
been enhanced to allow the use of the PBMITC, SBMITC, and IPSLIM elements.

Documentation:

Section 2.1.12.13 The CALCULATE SOIL SPRING VALUES Command, Volume 1,
GTSTRUDL Reference Manual.

Section 2.1.12.19 The CALCULATE PRESSURE Command, Volume 1, GTSTRUDL
Reference Manual.

11. The LARGE PROBLEM SIZE command has been improved to take advantage of the
increased resources available to computers with a 64-bit operating system.  This
improvement can help decrease the run time for very large jobs.

12. More comprehensive checking is now performed when processing the MEMBER LOAD
command to detect when the user has not specified the load component or type of load.

13. The SAVE/RESTORE process has been enhanced to allow data bases larger than 2 GB. 
Because GTSTRUDL relies on standard 32 bit file utilities, individual files are limited to
2 GB.  When internal  data bases exceed 2 GB,  a second file is created during the SAVE
process.  This file uses the same user specified file name as the standard SAVE file, but
with the extension “.gts2".  This extension is fixed and is not based on the extension of
the standard SAVE file, which has a default extension of “.gts” but may be different if
the user specifies an extension.  A successful SAVE of a data base greater than 2 GB will
issue a message similar to this:

 {   79} > save 'test'

 ****INFO_XXSAVE - Data base > 2GB and saved in files
 C:\32\LargeProblem\2Files\test.gts
 C:\32\LargeProblem\2Files\test.gts2

Only the standard SAVE file is referenced in the RESTORE command, but both files
(the standard SAVE file and the second .gts2 file) are required for a successful
RESTORE of a data base larger than 2 GB. If the SAVE file is copied or moved to a
different folder, be sure to include the .gts2 file if it exists.  If the .gts2 file is missing,
RESTORE will fail with an error similar to this:
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A successful RESTORE will issue a message similar to this:

 {   80} > RESTORE 'C:\32\LargeProblem\2Files\test.gts'
 

 ****INFO_XXREST - RESTORE complete from 2 files:
 C:\32\LargeProblem\2Files\test.gts
 C:\32\LargeProblem\2Files\test.gts2

The SAVE/RESTORE process for data bases less than 2GB is unchanged.

14. The NJP parameter has been added to the GTSES/GT64M ASSEMBLE command.  The
new command syntax is shown below:

The optional NJP parameter, vNJP, is used to control the number of joints that are
assembled into a typical global stiffness sub-matrix partition, where NJP = 6 is the
default.  NJP = 6 is adequate for the majority of cases; however, in the rare case when the
assembly process terminates due to a failure to allocate sufficient virtual memory , re-
executing the GTSES/GT64M ASSEMBLE FOR STATICS command with a larger
value of NJP – e.g. NJP = 12 – may permit the assembly to complete successfully.

Documentation

Section 2.1.13.3.2, Volume 1, Split Solver Static Analysis Using the GTSES/GT64M
Sparse Equation Solvers.

NJP

6GTSES
 ASSEMBLE FOR STATICS (NJP ) (OOC)

     vGT64M
→⎧ ⎫⎧ ⎫

⎨ ⎬ ⎨ ⎬
⎩ ⎭ ⎩ ⎭
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2.5 GTMenu

1. Dynamic mass specified using the INERTIA OF JOINTS command can now be
displayed.  The revised Results pulldown and the Display Joint Mass dialog are shown
below:

An example of the display of joint masses using the above dialog is shown below:



GT STRUDL New Features

2 - 15

2. The colors used for contour plots can now be changed.  The revised Options pulldown is
shown below:

The new Contour Colors dialog is shown below:
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3. Different colors can now be used for members and finite elements for the deformed
structure, mode shapes and transient animation as shown on the revised Attribute Colors
dialog below:
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4. A right mouse click can now be set using the Inquire Button so that only joint, members
or elements are selected.  This setting is retained until you change it using the Inquire
Button.  By default, the selection is set to All Types.  

The right mouse click setting is now displayed at the top of the Graphics Display.  The
Inquire Button pulldown and the display of the right mouse click setting at the top of the
Graphics Display are shown below:
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5. GTMenu can now produce selected result graphs for a member in a separate graphical
display window.  The results available for selection are local y displacement, local z
displacement and local force and moment diagrams and envelopes.

The modified Results pulldown and the new Graph Member Results dialog are shown
below:
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An example of the selected result graphs produced in a separate window is shown below:

Graphs for multiple members are available by clicking on the Next button shown above. 
In addition, the graphs may be printed or edited in the Scope Editor.
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6. Finite element edges and faces may now be labeled using the revised Display Model
dialog which is shown below:
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7. An automatic mesh feature for 2D elements has been implemented as a pre-release
feature on an experimental basis to mesh structures using only the structure’s outline
defined by Construction Lines including internal boundaries and line constraints.  Users
should save their models before using this feature due to its experimental nature.  This
feature is called GTMesh and is available using the hotkey  <Ctrl>8 (press Ctrl and 8
simultaneously).

The GTMesh dialog is shown below which allows the user to specify the external and
internal boundaries and constraints as well as setting the mesh spacing.



New Features GT STRUDL

2 - 222 - 22

An example of the boundary outline including the boundary around an internal opening is
shown below:

The resulting mesh using triangular elements (SBHT6) is shown below:
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A mesh generated for the same region using quadrilateral elements (SBHQ6) is shown
below: 

8. When refining a finite element mesh, there is now an option to split frame members
which are located in the mesh in the same way automatically.  The revised Refine a Finite
Element Mesh Dialog is shown below:    
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An example illustrating the automatic simultaneous refinement of members attached to a
finite element mesh is shown in the following figures with the members labeled before
and after the refinement to indicate the new members which were automatically created:

Before Refinement with original members labeled

After Refinement with new split members labeled
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9. Redraw Solid will now draw members specified using the CHANNEL and
POLYGONAL TUBE option of the MEMBER PROPERTIES Command.  Section
Names for Model Display, and Descriptors for the Property Legend Dialog are created
for these shapes as well as for I-SHAPES. The naming convention is as follows:

Section Names for Model Display.

Shape Prismatic Member Variable Member

I-SHAPE I(YD)x(ZD) varISHP

CHANNEL C(YD)x(ZD) varCHAN

POLYGONAL TUBE P(SD)-(OD) varPOLY

Descriptor for Property Legend Dialog

Shape Prismatic Member Variable Member

I-SHAPE I (YD)x(ZD)x(WBTK) I (YD)x(ZD)

CHANNEL C (YD)x(ZD)x(WBTK) C (YD)x(ZD)

POLYGONAL TUBE Polygon (SD) (OD)x(TH) P(SD) (OD)x(TH)

YD = Depth of the member.

ZD = Width of the flange.

WBTK = Web thickness.

SD = Sides in the polygon.

OD = Outer diameter through the corners.

TH = Thickness of the Polygonal Tube.

10. GTMenu now allows Landscape printing of graphics.  Select Portrait (the default
orientation) or Landscape from the File menu.  The current orientation is shown by a
check on the appropriate line in the File menu, and is remembered during the current
GTSTRUDL session, but the next time you run GTSTRUDL, the default orientation will
return to Portrait. In addition, when Print Portrait or Print Landscape is chosen from the
File menu, the standard printer selection dialog will be displayed.  

Print Preview and Edit will open the Scope Editor with the image in the current
orientation. The Print button on the Button Bar will use the current orientation without
the option to select a printer and send the current display to the default printer.
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No automatic determination of the “proper” orientation is done, so you can use the Print
Preview and Edit option to determine the proper orientation for the current display.  Note
that selecting an orientation (Portrait or Landscape) and then canceling the Printer
Selection dialog will change the orientation without actually printing. 

The new File menu:

Note: A new sample template (border box) for Landscape printing is supplied in the 32
installation folder: ...GTStrudl\32\LandscapeTemplate.ssc

11. You may now produce a contour plot of the mode shapes for a model which contains two
or three dimensional finite elements.  The revised Results pulldown dialog with the new
Mode Contours option available under Mode Options is shown below:
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The Element Mode Contours dialog and an example of the a mode shape contour plot are
shown below:
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12. A new option has been added to the Results pulldown which will allow the user to
graphically select the joints and elements to obtain the resultant forces along a cut which
is parallel to a global plane.  The modified Results pulldown is shown below:
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The new Sum Forces dialog is shown below along with the resulting output from
selecting joints and elements using this dialog:
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13. Redraw Solid and Display Model Profile functions will now draw the nine Unistrut
Profiles which are available in GTSTRUDL as shown below:

14. Multipoint and rectangular fencing are now available in the revised Mode Bar as shown
below:

A multi-point fence is specified as a sequence of vertices, while a rectangular fence is
specified as a selection window (diagonally opposite points).  In either case, the options
to select only what is totally enclosed or to include items that cross a fence boundary are
available for joint, member and element selection.
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15. The Display Parameters dialog has been enhanced so users may now change the Units in
the dialog and also display the following additional parameters: 

LX, FRLX, FRLY, FRLZ, FRUNCLF, TBLNAM, Yield Strength and Tensile Strength.

The enhanced Display Parameters dialog is shown below:
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16. The hotkey “L S” have been added to Label Supports.

17. When Refining a Finite Element Mesh and changing to a higher order element, the
mapping shown below is now followed which shows the lower order element and the
new higher order element:

Plane stress triangles map to the LST element

Plane stress quads map to the IPQQ element

Plate bending triangles produce an error saying unavailable

Plate bending quads map to the IPBQQ element

Tridimensional 6 node TRIP maps to the WEDGE15 element

Tridimensional 8 node bricks map to the IPSQ element

Plate triangles produce an error saying unavailable

Plate quads produce an error saying unavailable

18. The Generate Input File feature now generates an input file which includes the following:

Nonlinear Effects

Nonlinear Spring Properties

Nonlinear Spring Elements

Object commands and group titles

Elastic connections at the ends of members

TYPE RIGID PINs 

19. When checking for duplicate items such as joints, members or elements, the duplicates
are now labeled in the Graphical Display window if display is set for joints, members or
elements in the Label Settings dialog.

20. When checking for floating joints, the floating joints are now labeled in the Graphical
Display window if display is set for joints in the Label Settings dialog.

21. Finite elements are now labeled closer to their centroid.

22. Force and Moment Diagrams and value labels can now be rotated according to the Beta
angles on the members.  A FY Diagram is plotted in the local xy plane by default; a FZ
Diagram is plotted in the local xz plane by default; a MY Diagram is plotted in the local
xz plane by default; and a MZ diagram is plotted in the local xy plane by default.
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23. The Inquire dialog no longer disappears when the Graphics Window is activated.

24. Member loads on cable elements can now be displayed.

25. Split Members is now able to split ALL members.  The ALL option is now available on
the Mode Bar.

26. You may now create new Member Property Groups when creating members.  A new Add
Member Property Group option has been added to the Section Property Group dialog
during member creation.

27. Member Elastic Connections are now listed in the Inquire Output pop-up.

28. The efficiency of splitting members has been improved.

29. The color used for animation of mode shapes is now the same as the Attribute Color set
for mode shape display.

30. Refining a finite element mesh is somewhat faster now in that it does not display the
refinement until all elements have been split.  Previously, the elements would be drawn
as they were split.

31. Input files created from the File - Generate GT STRUDL text input ... menu pick or from
the GTMENU GENERATE INPUT FILE command now include loadings created with
the CREATE LOADING COMBINATION TYPE RMS and CREATE LOADING
COMBINATION TYPE ABSOLUTE commands (Section 2.1.11.3.4, Volume 1). 
Because these loadings require results to exist, they are generated as comments, preceded
by an informational comment, which will be one line in the generated input file:

$   This load must come after analysis commands. 
    $   Remove the $ to use this loading command.

For example, if in the generated input file, load 2002 appears like this:

$   This load must come after analysis commands...
$   CREATE LOADING COMBINATION  2002 TYPE RMS  -   
$      SPEC    2001            1.0000    999             1.0000          
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Add the appropriate analysis commands and remove the $ comment characters for load
2002:

COMPUTE RESPONSE SPECTRUM DISPLACEMENTS FORCES REACTIONS -
     MODAL COMBINATIONS RMS CQC

UNITS CYCLES SECOND
FORM MISSING MASS LOAD 999 'MISSING MASS LOAD' FROM RESPONSE SPECTRUM -

   LOAD 1001 CUTOFF FREQUENCY 8.529112 DAMPING RATIO 0.10
LOAD LIST 999
STIFFNESS ANALYSIS

CREATE LOADING COMBINATION  2002 TYPE RMS  -   
   SPEC    2001            1.0000    999             1.0000             

32. The Button Bar now has hotkeys, as follows:

<ctrl>p  for  print

<ctrl>q  for  query

<ctrl>a  for  annotate

<ctrl>t   for  label settings

<ctrl>z  for  zoom

<ctrl>r   for  rotate

<ctrl>d  for  redraw wireframe

<ctrl>s  for  redraw solid

33. Graphics hotkeys have been adapted to the Diagram window, produced from the Member
Results dialog (Results -> Member Results Graphs):

specifically, "m" = inquire for the current member;

 "j" = inquire for the current joints.
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2.6 GTSTRUDL Output Window

1. The Macros dialog has been improved to allow the use of a Personal Macros folder not in
the Common Macros folder, which previously was the only option.  Separate Personal
Macros are only available if you enable them in the Macros page in the GTSTRUDL
Options dialog.  If the “Use a separate Personal Macros folder” box is not checked,
Personal Macros are assumed to be located in the Common Macros folder, which is the
folder referenced in the “Macro folder location” box.  The Personal Macros folder option
was added in version 31, but was not noted in the Release Guide.

2. The “Display Response Spectrum File Data” dialog has been enhanced by the addition of
a check box option that allows you to indicate that the response spectrum acceleration
values from the selected curve are to be displayed in terms of g’s.  The check box,
entitled “Acceleration Unit = g,” is shown in check mode below:

3. The Edit - Paste verification message size has been increased to 15 lines from 10, and for
paste buffers larger than 15 lines, the first 10 lines of the buffer are displayed plus the last
5 lines of the buffer.
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2.7 Model Wizard

1. The Finite Element Mesh Wizard (2D Mesh) has three new elements added: PBMITC,
SBMITC and Q6CDRL.  See the documentation for these new elements included in this
Release Guide and Volume 3 of the GTSTRUDL Reference Manual.

2.8 Nonlinear

1. A new optional parameter, NGP iNGP, has been added to the NONLINEAR EFFECTS,
PLASTIC SEGMENT option that provides for the specification of either two or three
Gauss quadrature points for the numerical integration of the plastic segment equilibrium
equations.  The specification of NGP 3 provides for improved plastic segment accuracy
over a greater range of segment lengths when compared to that associated with NGP 2,
the default value that was originally implemented as a fixed constant.

Example

NONLINEAR EFFECTS
  PLASTIC SEGMENT NGP 3 END  -

FIBER GEOMETRY NTF 2 NTW 1 NBF 14 ND 12 LH 10.0  -
STEEL FY 50.0 FSU 50.00001 ESU 1.0 MEMBER 'COL4' 'COL8'

Documentation

The NONLINEAR EFFECTS Command;  Section 2.5.2.1, Volume 3 of the
GTStrudl Reference Manual.

2. In previous versions, member loads could not be applied to members for which the
PLASTIC SEGMENT nonlinear effect was specified.  This restriction has been removed
and all member load types are now supported for the PLASTIC SEGMENT nonlinear
effect.

Documentation

The NONLINEAR EFFECTS Command;  Section 2.5.2.1, Volume 3 of the
GTStrudl Reference Manual.

3. As of Version 32, the presence in the structural model of nonlinear elements of type(s)
IPCABLE, NLS, NLS4PH, and the friction bearing isolation element (NLSFBI), will
prevent the execution of any linear static or dynamic analysis operation.  An example of a
typical error message that is produced if this situation occurs is shown as follows:
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**** ERROR_CKNLEL -- Nonlinear members or elements detected during the
execution of a linear stiffness and/or dynamic
analysis.  Such members/elements are not permitted
for linear analyses.  Scan mode entered and analysis
terminated.

If the nonlinearity present in a model is due only to specifications by the NONLINEAR
EFFECTS command (geometry, tension/compression-only,  plastic hinge, etc.) then all
affected members will be assumed linear for any subsequent linear analysis operation,
static or dynamic.

2.9 Offshore

1. The offshore APIWSD21 punching shear check now can perform a code check for joints
with thickened cans.  Joints with thickened cans are discussed in the Section 4.3.5 of the
API WSD 21st Edition.  Also see GTSTRUDL’s detailed discussion of joints with
thickened cans in Section 4.4, Provisions 4.3-4, (Pa)c, (Qu)c, and (Qf)c of the
APIWSD21 users reference manual.

There are four new parameters applicable to the joints with thickened cans option of the
APIWSD21which are described as follows:

Parameter Default
  Name    Value  Meaning

Thickened Can Parameters

Tc 0.0 Thickness of the chord thickened can (Figure 2.8-1).  A user
specified value initiates allowable capacity computation
according to the Section 4.3.5, joints with thickened cans of
the API WSD 21st Edition.  Chord with thickened can capacity
computation requires the user to specify values for parameters
‘Tc’, ‘a-Can’, ‘b-Can’, and ‘c-Can’.

a-Can 0.0 Thickened can distance ‘a’ to the brace 1 (Figure 2.8-1). 
Thickened can capacity computation requires the user to
specify a value for parameter ‘Tc’.

b-Can 0.0 Thickened can distance ‘b’ to the brace 2 (Figure 2.8-1). 
Thickened can capacity computation requires the user to
specify a value for parameter ‘Tc’.

c-Can 0.0 Thickened can distance ‘c’ to the brace 3 (Figure 2.8-1). 
Thickened can capacity computation requires the user to
specify a value for parameter ‘Tc’.
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Brace Length,  Lc

1
2
3

2a + d1
2b + d2/sin 2

2c + d3

Figure 2.8-1     Chord thickened can geometry
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2. The offshore steel design code APIWSD21, which is based on the API Recommended
Practice 2A-WSD (RP 2A-WSD) Twenty-First Edition steel design code for Basic
Stresses, Hydrostatic Pressure, and Punching Shear, has been moved to the release
status.  The documentation for the APIWSD21 code may be found by selecting the Help
menu and then Reference Documentation, Reference Manuals, Offshore Loading,
Analysis, and Design, and then APIWSD21: API RP 2A-WSD, 21st Edition in the
GTSTRUDL Output Window.

3. A new International Standard ISO 19902:2007(E), First Edition, 2007-12-01, Petroleum
and natural gas industries – Fixed steel offshore structures has been implemented as a
prerelease feature.  The GTSTRUDL code name for this new offshore code is “19902-
07”.  The 19902-07 code performs Basic, Hydrostatic Pressure, and Punching Shear
stresses check according to International Standard ISO 19902:2007(E).  This new code,
19902-07, may be used to select or check Circular Hollow Sections (Pipes).  The
prerelease documentation for the 19902-07 code may be found by selecting the help
menu and then Reference Documentation, Reference Manuals, Offshore Loading,
Analysis and Design, and 19902-07: ISO 19902:2007(E), First Edition in the
GTSTRUDL Output Window.

4. The GTSELOS WAVE command has been enhanced to include the selection of an
updated version of the STREAM FUNCTION wave model (Section 7.10, Volume 7,
User Reference Manual).  The original implementation of the stream function wave
model was due to Dean (1965) and demonstrated significant deficiencies over a wide
range of water depths.  The enhanced WAVE command provides for the additional
selection of the Fenton (1988) stream function model, which is a higher order Fourier
Series solution that produces significantly improved solutions, particularly in shallow
water depths.
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2.10 Steel Design

1. Efficiency improvements have been added to the EC3-2005 code.  Time to code check
(CHECK) or design (SELECT) for jobs with large number of loadings have been
reduced.  Also the GTSES option has been improved to allow models with a large
number of load cases to be processed more efficiently during a code check or design.

2. Under previous versions of GTSTRUDL, the message below indicates that nonlinear
analysis is required for code checking based on LRFD codes:

 **** WARNING_STTECC -- Code check based on the LRFD code requires nonlinear analysis.
                        Nonlinear analysis has not been performed for the following loadings:
                        1       

According to the AISC 13th Edition Code (GTSTRUDL AISC13 code), nonlinear
analysis is required regardless of the method (LRFD or ASD) used.  For GTSTRUDL
Version 32, the message above has been modified to reflect this AISC 13th Edition
requirement:

 **** WARNING_STTECC -- Code check based on the AISC13 code requires nonlinear analysis.
                        Nonlinear analysis has not been performed for the following loadings:
                        1       

3. The steel design code EC3-2005, which is based on the Eurocode 3: Design of Steel
Structures, Part 1-1 General rules and rules for buildings, DS/EN 1993-1-1:2005(E), has
been moved to release status.  The documentation for the EC3-2005 code may be found
by selecting the Help menu and then Reference Documentation, Reference Manuals,
Steel Design  and then EC3-2005: Eurocode 3, 2005 in the GTSTRUDL Output Window.

4. When a value of “YES” has been specified for the parameter “TowerCK,” the
slenderness ratios are checked according to the transmission tower code provisions.  This
option is applicable to the AISC13 and ASD9 codes for single and double angle cross-
sections and was a new option that  was added to GTSTRUDL Version 31.
In GTSTRUDL Version 32, this option has been modified so that the AISC13 or ASD9
slenderness ratios L/r, KL/r, B7 TEN, and B7 COMP are checked as informative
provisions rather than pass/fail conditions.  This means that as of Version 32, only the
transmission tower slenderness ratios SLENT and SLENC are checked as pass/fail
provisions.  Previously, all slenderness ratios L/r, KL/r, B7 TEN, B7 COMP, SLENT,
and SLENC (transmission tower, AISC13, and ASD9) were checked as a pass/fail
provisions. 

5. Additional error checking for parameters CODE, TBLNAM, and STEELGRD have been
added into the steel design parameter command.  The user specified parameter values for
the parameters CODE, TBLNAM, and STEELGRD are now checked against accepted
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values and if the specified value is incorrect, an error message is given and the scan mode
is set.

6. Efficiency improvements have been made to both the member selection and code
checking functions when the external file solver is active and analysis results are stored
in files on external storage devices.  In particular, virtual memory demands have been
reduced, enabling  the CHECK and SELECT commands to handle the required numbers
of members and loading conditions more efficiently.  The external file solver is activated
by the ACTIVE SOLVER GTSES or GT64M command (Section 2.1.13.4, Volume 1) or
when the GTSES or GT64M options are specified in the STIFFNESS ANALYSIS
command (Section 2.1.13.2, Volume 1) or the SOLVE option of the EIGENPROBLEM
PARAMETERS command (Section 2.4.5.2, Volume 3).

7. Geometric checks in Codes N690-94, NF-2004, and NF-2007 for local stability are now
stored as informative checks. This will prevent GTSTRUDL from reporting geometric
checks instead of stress checks on the Code Check or Design Summary.

8. The parameter ALSTRINC which can be used to modify the allowable stresses can now
accept negative values in order to allow the designer to reduce the allowable stresses for
a list of loads.  This parameter is available for the ASD9, ASD9-E, UNISTRUT,
APIWSD20 and APIWSD21 Codes and will be available for the N690-94 code in
Version 32.

9. The steel design code, ASCE4805, which is based on the 2005 edition of the ASCE/SEI,
Design of Steel Transmission Pole Structures Specification has been implemented as a
pre-release feature.  The ASCE/SEI 48-05 Specification is based on ultimate strength
methods using factored loads. 

The ASCE4805 Code may be used to select or check any of the following shapes:

Design for axial force, bi-axial bending, and torsion:

Pipes
Regular Polygonal Tube
Structural Tubing 

The documentation for the ASCE4805 code may be found by selecting the Help menu 
and  then Reference Documentation, Reference Manuals, Steel Design, and “ASCE4805"
in the GTSTRUDL Output Window.
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2.11 Steel Tables and GTTABLE

1. The output of the Table print commands will no longer overflow the output field and be
printed as “**************” when the value is larger than the reserved field.  The
values that are too large for the reserved fields are automatically converted to an
exponential format before being printed.  This will prevent any print overflow problem.

2.12 Base Plate Wizard

1. The command “SET ELEMENTS HASHED” is now added to the GTSTRUDL input file
for models greater than 200 joints to increase processing speed.

2. The Base Plate Wizard Release Guide can be viewed from the Help menu.

3. The Nonlinear Analysis option for Generate Input now includes the ability to request
NONLINEAR ANALYSIS GTSES, which uses the external file solver.  This can run
much faster for very large models, but note that the external results files will now be
included in your working directory.
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4. The Open New Attachment File dialog (available from the Options menu) has been
changed to give more control over handling attachment data not in the default
Attachment File.  The changed dialog looks like this:

If you check the “Change my default attachment file to this one” box, these new features
appear:

See Appendix A2 in the Base Plate Wizard User Manual for an explanation of the various
options.
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5. A new option has been added to Attachments to allow specification of attachment lines as
“Contact Only”, corresponding to lines of the attachment that are in contact with the
plate, but are not welded therefore allowing the attachment line and the plate to separate
under tension.  This option is available with the “Edit Weld Status” button when editing
an attachment.  Standard profiles may have the weld status edited, but they will become
‘arbitrary’ (user defined) profiles upon saving.  See “Section 3.2.1 Changing Weld Status
for Attachments” in the Base Plate Wizard User Manual for an explanation of how to edit
the weld status and how Contact Only is modeled.

New ‘Edit Weld Status’ button.

6. The Plate Stress results dialog has a new option to include the location (X and Y
coordinates) of each joint.  Check the ‘Location’ box to add new columns to the right of
the display. 
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7. When allowable forces are specified for anchors, you can now elect to use an interaction
ratio limit of 1.2.  Limits for tension and shear remain fixed at 1.0.

8. New options have been added to Results Summary (Section 11.1) to add more
information to the Anchor results output.

This option will add the names of the loads that caused the maximum interaction, tension
and shear ratios.  Load names are printed underneath the standard anchor results output.

  Anchor P/F Intact Tension   T allow Ratio    Shear  V allow Ratio
  ------ --- ------ -------- -------- ----- -------- -------- -----
  B1      F  1.0625   2125.0   2000.0 1.063    706.9   1500.0 0.471
                T-1      T-1                       5

This option will output the individual anchor results ordered by loading  following the
standard anchor results output.

  Individual anchor results, by load
  Anchor     Load I_ratio P/F    Axial A_Allow A_Ratio    Shear V_Allow V_Ratio
  ------ -------- ------- ---  ------- ------- -------  ------- ------- -------
      B1        A  0.0903  P    -106.1  2000.0  0.0530     55.9  1500.0  0.0373
      B2           0.0938  P     -23.6  2000.0  0.0118    123.0  1500.0  0.0820

      B1        2  0.2021  P    -262.9  2000.0  0.1315    106.0  1500.0  0.0707
      B2           0.1252  P    -109.0  2000.0  0.0545    106.1  1500.0  0.0707



New Features GT STRUDL

2 - 462 - 46

9. The Anchor Results dialog has a new option to create commands for the ANCHOR
CONFIGURATION command (Section 2.9.2 “The ANCHOR CONFIGURATION
Command”, Volume 3, GTSTRUDL Reference Manual).  You can create commands to
transfer the calculated loads for each anchor, and optionally the anchor coordinates, from
the Base Plate Wizard to a GTSTRUDL input file used to check the anchor capacity with
ACI Appendix D.

Click the ‘Write ANCHOR LOADS’ button to bring up the Write Anchor command
dialog.

See Section 11. Results in the Base Plate Wizard User Guide.
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10. Two new Anchor Patterns have been added: “4 corners + interior fill” to create a grid of
anchors, and “Arc/Circle” to place anchors in a circular arrangement.  See Section 4.1
Adding Anchors for documentation of these two new patterns.  The new Anchor Patterns
dialog looks like this:

2.13 Base Plate Anchors

1. A new capability to calculate the capacity of structural anchors in concrete by the
methods of ACI 318-05 Appendix D has been added.  Commands are provided to enter
the anchor properties, base plate configuration and request a capacity check. The new
commands are documented in Volume 3, Section 2.9.

• The ANCHOR TYPE command is used to describe anchor properties such as effective
embedment length and diameter.
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ANCHOR  TYPE 'a_ name'    -

HEF h  DIAMETER d  FUTA f  (ASE a )  

(
BRITTLE
DUCTILE ) (WASHER t )

1 1 1 1

1

cast - in
post - installed

⎧
⎨
⎩

⎫
⎬
⎭
−

→⎧
⎨
⎩

⎫
⎬
⎭

• The ANCHOR CONFIGURATION command is used to describe the geometry and
properties of the base plate to be checked, along with relevant properties of the bearing
surface, including edge location. 

ANCHOR CONFIGURATION ‘ac_name’ (‘ac_title’)
(plate)
bearing_surface
anchor_location
anchor_loads
(rows)
(edge)
(edge_distances)
(phi_category)
(sup_reinforce)

END (ANCHOR CONFIGURATION)

• The PRINT ANCHOR command will output the specified anchor type or configuration
data.

PRINT ANCHOR TYPE
PRINT ANCHOR CONFIGURATION

• The CHECK ANCHOR CONFIGURATION command checks a previously created
anchor configuration with the requirements of ACI 318 “Appendix D - Anchoring to
Concrete”.

{ }CHECK ANCHOR (CONFIGURATIONS) ( ACI - 05 ) -

ALL
(SEISMIC)

list

→

→⎧ ⎫
⎨ ⎬
⎩ ⎭
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2.14 Scope Editor

1. A Circle has been added to the Tools menu.  Circles are created by holding down the left
mouse button and then dragging the circle to determine the orientation and diameter of
the diameter of the circle.
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2. Triangle has been added to the Tools menu.  Triangles are created by left-clicking three
points to indicate the vertices of the triangle.

3. Polygon has been added to the Tools menu.  Left-click to initiate construction.  A new
vertex is added for each new left-click until the first vertex is clicked, closing the
polygon.
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4. The Fill shape and Outline Only options have been added to the Tools menu available
from the right-mouse click pop-up menu. Fill shape causes the selected (highlighted)
objects to become filled with the current global brush color (set with Format - Color...). 
Outline only causes the selected (highlighted) objects to become outlined shapes,
without interior color. 
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5. Export Rich Text has been added to the File menu. This selection creates a file with
“.rtf” extension that can be read in various Microsoft programs. This RTF file contains all
elements that are currently visible on the Scope Editor.

6. The Move and Scale option has been added to the Tools menu available from the right-
mouse click pop-up menu. This option allows many items to be moved and scaled easily.

• Select elements to be moved and/or scaled.
• Right click a selected element and choose the Move and Scale option from the Tools
menu. This will create a bounding rectangle encompassing all the selected elements, with
one control square at each corner.  This bounding box will be your guide to where and
what size the completed operation will look like.
• To move, place the cursor in one of the control squares.  Left-click and drag the
bounding rectangle to one corner of its new position. Release the mouse when the
rectangle is properly placed. To leave the bounding rectangle in place (scale only), don’t
move the mouse before releasing.
• To scale, place the cursor in one of the control squares - the corner opposite the selected
control square will be considered the anchor for scaling. Left-click and drag the corner of
the bounding rectangle.  The bounding rectangle will resize.  When the desired size is
reached, release the left mouse button.  To leave the current scaling (move only),  don’t
move the mouse before releasing.
• The selected elements will then be redrawn with the correct translation and scaling to
fill the bounding rectangle.
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7. The Options dialog, available from the View menu, has a new option to specify a
Landscape  template to be used when GTMenu sends a file in Landscape orientation.

8. A new feature has been added to Template processing, allowing you to set the margins
for each Template within the Template itself by adding a text entry beginning with
"<<Margins" followed by the margin sizes Left, Top, Right, Bottom in 0.01 inch  (0.25
mm) increments.  Margin values are separated by spaces and/or commas.  All four
margin values are required.  If this option is used, the margin values specified in the
Options dialog are ignored. "Template processing" is what happens when you check one
of the "Automatically apply a template..." check boxes in the Options dialog, as shown
above.

This new feature allows you to easily switch between Templates without having to
respecify margins in the Options dialog. 

Example:
See "PortraitTemplate.ssc" in C:\Program Files (x86)\GTStrudl\32.  The text entry above
the title box is:

<<Margins 75, 75, 75, 125
which sets the Left margin as 0.75" (19 mm), theTop margin as 0.75" (19 mm), the Right
margin as 0.75" (19 mm) and the Bottom margin as 1.25" (32 mm).
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Chapter 3

Error Corrections

This chapter describes changes that have been made to GTSTRUDL to correct errors.
These errors may have produced aborts, incorrect results, or restricted use of a feature in
previous versions of GTSTRUDL.  The error corrections are discussed by the primary
feature areas of GTSTRUDL.

3.1 DBX

1. In previous versions the results files created by the WRITE DBX MEMBER
RESULTS command include results data for finite elements found in the command
member list.  Finite elements are now skipped.

(No GPRF Issued)

2. The WRITE JOINT ATTRIBUTES command will no longer abort if an undefined
joint is included in the list of joints.

(No GPRF Issued)

3. The WRITE MEMBER RESULTS command will no longer write results for the first
two nodes of finite elements in the specified member list.  Finite elements are now
ignored in this command.

(No GPRF Issued)

4. Previous versions  of  WRITE DYNAMIC STIFFNESS could possibly be missing
the final matrix rows due to incorrectly closing the generated file.  Usually, when
GTSTRUDL is closed, the file buffer (unwritten data) is automatically flushed
(written to the file), but for very large output files the automatic feature can fail,
resulting in an incomplete output file.  This has been corrected in Version 32.

(No GPRF Issued)
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3.2 Dynamic Analysis

1. The COMPUTE MODAL DAMPING command no longer aborts when rigid body
modes,. i.e. modes that have zero-value eigenvalues, have been computed by the
preceding eigenvalue analysis.  The computed modal damping ratio is set equal to
0.0 for such modes.

(GPRF 2011.09)

2. The TIMES ALL option of the COMPUTE TRANSIENT and COMPUTE STEADY
STATE commands no longer limits the number of time points for which transient
and steady state responses are computed to 65536.  All specified time points are now
processed under the TIMES ALL option of these commands.  Note that the
maximum permitted number of time points is 4 million (see Section 2.2, Item 2).

(GPRF 2011.13)

3. GTSTRUDL no longer aborts when using the LIST DYNAMIC PARTICIPATION
FACTORS ORDER BY Command with the absence of mass participating in one of
the principal directions.

(GPRF 2011.04)

3.3 External File Solver

1. When the External File Solver is active, the deletion of existing entities (i.e. joints,
members, and finite elements) and the addition of new entities between successive
analysis steps will no longer create inconsistencies between the number and order of
the entities reflected in the analysis results data stored in the external files before the
deletions/additions operations and the number and order of the entities actually
present in the model following the deletions/additions operations.”

(GPRF 2010.05)

3.4 Finite Elements

1. Incorrect results will no longer result if a RIGIDITY MATRIX is specified for
elements IPSL, IPSQ and TRANS3D.  The Rigidity Matrix input is not supported for
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these elements as shown in the Element Dictionary in Section 2.3.4 of Volume 3 of
the GTSTRUDL Reference Manuals.  Now, the following error message is output
and the scanning mode is entered:

**** ERROR_STERR5-4 -- RIGIDITY MATRIX IS NOT SUPPORTED  FOR ELEMENT xxxx
           SCANNING MODE ENTERED.

(GPRF 93.09)

2. The following warning message for temperature gradient loadings on the BPHT,
BPHQ, SBHT, SBHQ, SBHT6 and SBHQ6 elements will now output the correct
loading name.  An example of the warning message is shown below:

****WARNING_THCE30 -- NOT ALL JOINTS FOR ELEMENT 1        IN LOADING 3        HAVE
A SPECIFIED TEMPERATURE GRADIENT.        A VALUE OF 0.0 WILL USED FOR THE
TEMPERATURE GRADIENT.

Previously, the warning message could output an incorrect loading name. 

 (No GPRF issued)

3.5 General

1. Changes to stiffness and flexibility matrix member properties specified by giving the
new matrix property values in the MEMBER PROPERTIES
STIFFNESS/FLEXIBILITY command in CHANGES mode are not reflected in the
results of any subsequent analysis (stiffness, dynamic, nonlinear, etc.) in all  versions
of GTStrudl prior to Version 32.  This problem has been corrected and such changes
are now properly reflected in subsequent analysis results.

(GPRF 2011.01)

2. The UNSYMMETRIC SECTION option of the  LIST SECTION STRESSES
command has been corrected to utilize all the significant decimal values of the
moment of inertia with respect to the Z axis (IZ).  

(GPRF 2010.09)

3. EXISTING MEMBERS ONLY and EXISTING ELEMENTS ONLY now work
correctly when used with the CONSTANTS command. 

(No GPRF issued)
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4. When multiple master joints are specified for a given slave joint, the documented
action is taken (i.e. all but the first master-slave specification are ignored; Sections
2.6.5.1 and 2.6.5.2.2, Volume 3 of the reference manual); however, no message so
indicating is issued.  This situation has been improved.  Now, a warning message is
issued  indicating that the second and later specifications of additional master joints
for the same slave joint is invalid with scan mode turned on.

(GPRF 2011.05)

5. The PRINT MEMBER PROPERTIES command for PIPE tables which prints the ID,
OD, and TH-PIPE values are now printing these values.

(GPRF 2011.08)

An example of PRINT MEMBER PROPERTIES output is as follows:

 {   52} > 
 {   53} > MEMBER PROPERTIES
 {   54} >  1 TO 3   T 'WSPIPE'  'P12X33'
 {   55} >  4 TO 6   T 'M/S/HP13'  'S6X12.5'
 {   56} > 
 {   57} > PRINT MEMBER PROPERTIES
1
 ****************************************
 *  PROBLEM DATA FROM INTERNAL STORAGE  *
 ****************************************

 JOB ID - FR418        JOB TITLE - Check PRINT MEMBER PROPERTIES for PIPE     

 ACTIVE UNITS -  LENGTH        WEIGHT        ANGLE       TEMPERATURE      TIME                
                   INCH          LB            DEG           DEGF          SEC               

 MEMBER PROPERTIES--------------------------------------------------------------------------------------------------------/
 MEMBER/SEG TYPE                          AX         AY         AZ         IX         IY         IZ         SY         SZ
                                                     YD         ZD         YC         ZC         EY         EZ
                                                     ID         OD        TH-PIPE     SC

 1        TABLE      WSPIPE                9.817      4.909      4.909    383.700    191.824    191.824     30.090     30.090
                     P12x33                          12.750     12.750      6.375      6.375      0.000      0.000
                                                     12.250     12.750      0.250      0.000

 2        TABLE      WSPIPE                9.817      4.909      4.909    383.700    191.824    191.824     30.090     30.090
                     P12x33                          12.750     12.750      6.375      6.375      0.000      0.000
                                                     12.250     12.750      0.250      0.000

 3        TABLE      WSPIPE                9.817      4.909      4.909    383.700    191.824    191.824     30.090     30.090
                     P12x33                          12.750     12.750      6.375      6.375      0.000      0.000
                                                     12.250     12.750      0.250      0.000

 4        TABLE      M/S/HP13              3.660      1.392      1.594      0.167      1.800     22.000      1.080      7.340
                     S6x12.5                          6.000      3.330      3.000      1.665      0.000      0.000
 
 5        TABLE      M/S/HP13              3.660      1.392      1.594      0.167      1.800     22.000      1.080      7.340
                     S6x12.5                          6.000      3.330      3.000      1.665      0.000      0.000
 
 6        TABLE      M/S/HP13              3.660      1.392      1.594      0.167      1.800     22.000      1.080      7.340
                     S6x12.5                          6.000      3.330      3.000      1.665      0.000      0.000
 

 ****************************************
 *  END OF DATA FROM  INTERNAL STORAGE  *
 ****************************************
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6. The LOCATE DUPLICATE JOINTS command no longer possibly aborts when
properties have not been specified for the existing members or elements.  The
absence of properties did not always cause an abort, but now the absence of
properties is handled properly in all situations.

(GPRF 2011.10)

7. The GTSTRUDL abort, which may occur when the external file solver is active, has
been eliminated.  The abort was reported one time under the very extreme conditions
of a very large model having numerous and assorted stiffness and dynamic analyses
and is therefore deemed very unlikely to occur.  The external file solver writes and
stores analysis results in files on the hard drive and is activated in conjunction with
the activation of the high performance sparse equation solvers when the ACTIVE
SOLVER GTSES/GT64M command is given prior to any subsequent stiffness and
dynamic analysis executions.  The external file solver also is activated by the
DYNAMIC PARAMETERS/USE EXTERNAL FILE SOLVER command.

(GPRF 2011.14)

8. The abort of the FORM UBC97 LOAD command caused by the presence of
undefined joints has been corrected.

(GPRF 2011.15)

9. The DEAD LOAD and SELF WEIGHT LOAD commands with the INCLUDE
FINITE ELEMENTS option now state that the dead load for IPCABLE elements is
not computed.

(No GPRF issued)

10. The CALCULATE PRESSURE command no longer aborts if the GTSES/GT64M
solvers are used.

(No GPRF issued)

11. The error that limited the maximum number of CREATE PSEUDO STATIC LOAD
commands to 100 when the external file solver is active has been corrected.

(GPRF 2010.06)

12. GTSTRUDL static and dynamic analyses no longer abort when a slave joint makes
reference to an inactive or deleted master joint.

(GPRF 2011.16)
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3.6 GTMenu
(GPRF’s are not issued for GTMenu unless specifically noted below)

1. Member Elastic Connections are no longer lost if changes are made in GTMenu.

2. In some instances, loadings which had exactly 5 characters in their name would not
draw the loads.  This has been corrected.

3. Debug output will not longer be printed when performing a Redraw Solid for barbell
concrete wall sections.

4. If the first section of a variable section is prismatic, Redraw Solid will now draw it
as a straight line.

5. Split members now works for more than 20 different split operations while the Split
Member dialog is active.  You may have up to 1000 different split operations while
the Split Member dialog is active.

6. Generate Input File now checks member data more completely in order to eliminate
an abort.

7. An abort has been corrected when performing a Diagram Envelope.

8. GTMenu no longer marks all joints when they are being selected to display supports.

9. The aspect ratio calculation has been removed for 1-D elements such as the
IPCABLE element.

10. Split members with variable spacing and absolute specs now works correctly if the
members are long and the length unit is mm.

11. An abort no longer occurs if an element has a thickness but the type of element has
not been specified.

3.7 Model Wizard
(GPRF’s are not issued for the Model Wizard unless specifically noted below)

1. The Braced Plane Frame no longer generates incorrect models if only AB or CD
knee bracing is selected for all bays.
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3.8 Nonlinear Analysis

1. Members having stiffness/flexibility matrix properties no longer have the potential
to cause GTSES nonlinear analysis convergence problems when such members also
are designated as having nonlinear effects of any kind.  Nonlinear effects for such
members are now ignored and the following message is issued when this condition
is detected:

 **** WARNING_NLCNCK -- Nonlinear effects have been specified for
members having stiffness/flexibility
matrix properties. Nonlinear effects for
such members are ignored.

(GPRF 2011.03)

2. Plane and space frame members that have been designated as NLS CONNECTION
members by the NONLINEAR EFFECTS command may cause problems that
prevent the successful completion of a nonlinear static analysis under the following
conditions:

1) There are two or more members that are designated as NLS CONNECTION.

2) Different members specify different NLS CONNECTION degrees of
freedom with different nonlinear spring curves at different member ends
(start or end), as illustrated by the following command sequence:

  
NONLINEAR EFFECTS
  GEOMETRY ALL MEMBERS
  NLS CONNECTION MEMBERS 5 6 START MOMENT Y 'My' Z 'Mz'
  NLS CONNECTION MEMBERS   7 START MOMENT Y 'My' END MOMENT Y 'My'

In the commands above, the fact that the NLS CONNECTION specs specify
different nonlinear spring curves for different degrees of freedom among
members 5, 6, and 7, may precipitate this problem.

3) During the nonlinear analysis, the displacement or rotation of a NLS
CONNECTION spring exceeds the displacement/rotation bounds specified
for the spring in the NONLINEAR SPRING PROPERTIES curve data.

When these conditions occur, the nonlinear analysis may abort or terminate
prematurely, accompanied by an unintelligible error message.

This problem has been corrected.

(GPRF 2011.07)
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3. Nonlinear static analyses for multiple active loading conditions in which the friction
bearing isolation element, i.e. element type NLSFBI, is used no longer encounter
equilibrium convergence failures in the analyses for the second and subsequent
loading conditions.

(GPRF 2011.11)

3.9 Offshore

1. The random abort of the PERFORM FATIGUE ANALYSIS command has been
corrected.  This condition was caused by the case when the first wave of the wave
data set has fewer time stepping points than a subsequent wave in the data set.

(No GPRF issued)

2. A sequence of PERFORM FATIGUE ANALYSIS DETERMINISTIC command
executions following a COMPUTE FATIGUE LJF INCLUDE command may
produce slightly different fatigue damage and fatigue life results depending on the
order in which multiple wave load files were previously processed by the READ
WAVE LOADS NEW command.  This  discrepancy has been corrected.

(No GPRF issued)

3. The DIRECTION option of the LIST FATIGUE STRESSES and LIST FATIGUE
TRANSFER FUNCTIONS commands now reports the requested fatigue analysis
results only for the specified wave DIRECTIONs.  In previous versions, the
DIRECTION option was ignored and the requested fatigue analysis results were
always reported for all available wave directions.

(No GPRF issued)

3.10 Static Analysis

1. The command STIFFNESS ANALYSIS GTSES WITHOUT REDUCE BAND will
now always turn off bandwidth reduction.

(No GPRF issued)

2. When the DUMP OFF command is given and a self-weight load is present, the
GTSES and GT64M solvers now complete the solution.  Previously, the solvers
would exit the assembly process without performing the solution.

(No GPRF issued)
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3. Static analysis using the GTSES/GT64M sparse equation solvers could prematurely
complete, with no results computed, when one of the active independent loads was
computed by the SELF-WEIGHT or DEAD LOAD command for at least one active
member/finite element having a DENSITY value equal to exactly 0.0.  This
condition has been corrected.

(GPRF 2011.02)

3.11 Steel Design

1. The uninitialized variable in the AISC13 code which resulted into an incorrect
lateral-torsional buckling (LTB) computation has been fixed.  Also the user specified
values for the parameters UNLCFTF and UNLCFBF are correctly considered in the
lateral-torsional buckling equations.

(GPRF 2012.01)
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Chapter 4

Known Deficiencies

This chapter describes known problems or deficiencies in Version 32.  These
deficiencies have been evaluated and based on our experience, they are seldom encountered
or there are workarounds.  The following sections describe the known problems or
deficiencies by functional area.

4.1 Finite Elements

1. The ELEMENT LOAD command documentation indicates that header information
such as type and load specs are allowed.  If information is given in the header and
an attempt is made to override the header information, a message is output indicating
an invalid command or incorrect information is stored.  (GPRF 90.06)

2. The CALCULATE RESULTANT command may either abort or print out an
erroneous error message for cuts that appear to be parallel to the Planar Y axis.
(GPRF 94.21)

3. If a superelement is given the same name as a member or finite element, an abort will
occur in the DEVELOP STATIC PROPERTIES command.  (GPRF 95.08)

4. The curved elements, TYPE ‘SCURV’ and ‘PCURV’ will produce incorrect results
for tangential member loads (FORCE X).  An example of the loading command
which will produce this problem is shown below:

LOADING 1
MEMBER LOADS
1  FORCE  X  UNIFORM   W  -10

where member (element) 1 is a ‘SCURV’ or ‘PCURV’ element.

(GPRF  99.13)
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4.2 General Input/Output

 1. An infinite loop may occur if a GENERATE MEMBERS or GENERATE
ELEMENTS command is followed by a REPEAT command with an incorrect
format.  An example of an incorrect REPEAT command is shown below by the
underlined portion of the REPEAT Command:

GENERATE  5  MEM  ID  1  INC  1  FROM  1  INC  1  TO  2  INC  1
REPEAT  2  TIMES  ID  5  FROM  7  INC  1  TO  8  INC  1

Only the increment may be specified on the REPEAT command.  (GPRF 93.22)

 2. Rigid body elements cannot be deleted or inactivated as conventional finite elements.
The specification of rigid body elements as conventional finite elements in the
INACTIVE command or in DELETIONS mode will cause an abort in a subsequent
stiffness, nonlinear, or dynamic analysis.  (GPRF 97.21)

 3. The path plus file name on a SAVE or RESTORE is limited to 256 characters.  If the
limitation is exceeded, the path plus file name will be truncated to 256 characters. 
This is a Windows limitation on the file name including the path.   (No GPRF issued)

 4. Object groups, created by the DEFINE OBJECT command, may not be used in a
GROUP LIST as part of a list.  If the OBJECT group is the last group in the list,
processing will be correct.  However, if individual components follow the OBJECT
group, they will fail.  Also, you can not copy members or joints from the OBJECT
group into a new group.  (GPRF 99.26)

5. Numerical precision problems will occur if joint coordinate values are specified in
the JOINT COORDINATES command with more than a total of seven digits.
Similar precision problems will occur for joint coordinate data specified in automatic
generation commands.  (GPRF 2000.16)

 6. Internal member results will be incorrect under the following conditions:

1. Dynamic analysis is performed (response spectra or time history)

2. Pseudo Static Loadings are created

3. Buckling Analysis is Performed

4. Internal member results are output or used in a subsequent steel design after
the Buckling Analysis.
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In addition, the eigenvalues and eigenvectors from the Dynamic Analysis are
overwritten by the eigenvalues and eigenvectors from the Buckling Analysis.

We consider this problem to be very rare since we had never encountered a job
which contained both a Dynamic Analysis and a Buckling Analysis prior to this error
report.

Workaround:
Execute the Buckling Analysis in a separate run which does not contain a
dynamic analysis.

Alternatively, execute the Buckling Analysis before the Dynamic Analysis
and output the Buckling results and then perform a Dynamic Analysis.  The
Dynamic Analysis results will then overwrite the buckling multiplier and
mode shape which is acceptable since the buckling results have been output
and are not used in any subsequent calculations in GTSTRUDL.

(GPRF 2004.14)

4.3 GTMenu

1. Gravity loads and Self-Weight loads are generated incorrectly for the TRANS3D
element.

Workaround: Specify the self-weight using Body Forces under Element Loads.
ELEMENT LOADS command is described in Section 2.3.5.4.1 of
Volume 3 of the GTSTRUDL Reference Manual.

(GPRF 95.18)

2. The Copy Model feature under Edit in the Menu Bar will generate an incorrect
model if the model contains the TRANS3D element.

Workaround: Use the DEFINE OBJECT and COPY OBJECT commands in
Command Mode as described in Section 2.1.6.7.1. and 2.1.6.7.5 of
Volume 1 of the GTSTRUDL Reference Manual.  

(GPRF 95.21)
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3. The Load Summations option available under CHECK MODEL will produce
incorrect load summations for line, edge, and body loads on all finite elements.  The
Load Summations are also incorrect for projected loads on finite elements.  The load
summations for line and edge loadings should be divided by the thickness of the
loaded elements.  The body force summations should be multiplied by the thickness
of the loaded elements for two-dimensional elements.

Workaround: You can check the load summation by specifying the LIST SUM
REACTIONS command after STIFFNESS ANALYSIS.

(No GPRF issued)

4. Projected element loads will be displayed incorrectly when they are created or when
they are displayed using Display Model 6 Loads.  

Workaround: Verify that the loads are correct in the GTSTRUDL Output Window
using the PRINT LOAD DATA command or by checking the
reactions using LIST SUM REACTIONS.

(No GPRF issued)

4.4 Scope Environment

 1. OVERLAY DIAGRAM in the Plotter Environment produces diagrams that are much
smaller relative to the plot size than the Scope environment does.  This is because the
structure plot is magnified to fill the Plotter graphics area, but the height of the
diagram is not increased.  As a work-around, use the PLOT FORMAT SCALE
command to decrease the scale factor, which will increase the size of the diagram.
The current value is printed with a Scope Environment OVERLAY DIAGRAM.
The value printed with a Plotter Environment OVERLAY DIAGRAM is incorrect.
For example, if a Moment Z diagram is OVERLAYed with a scale factor of 100.0
on the Scope, the command PLOT FORMAT SCALE MOMENT Z  50. would scale
a reasonable OVERLAY DIAGRAM for the Plotter. (GPRF 96.19)

4.5 Offshore Analysis and Design – GTSELOS

1. The GTSELOS linear wave implementation produces incorrect wave kinematics and
wave forces at water depths greater than approximately 525 feet (160 meters).

(No GPRF issued)
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Chapter 5

Prerelease Features

5.1 Introduction

This chapter describes new features that have been added to GTSTRUDL but are
classified as prerelease features due to one or more of the following reasons:

1. The feature has undergone only limited testing.  This limited testing
produced satisfactory results.  However, more extensive testing is required
before the feature will be included as a released feature and documented in
the GTSTRUDL User Reference Manual.

2. The command formats may change in response to user feedback

3. The functionality of the feature may be enhanced in response to user
feedback.

The Prerelease features are subdivided into Design, Analysis, and General categories. 
The features in these categories are shown below:

5.2  Design Prerelease Features

5.2.1 LRFD3 Steel Design Code.  Rather than use the LRFD3 code
which is a prerelease feature, users should use the AISC13 code
which is now a released feature.

5.2.2 ACI Concrete Code 318-99.  Rather than use the 318-99 code
which is a prerelease feature, users should use the 318-05 code
which is now a released feature.

5.2.3 Rectangular and Circular Concrete Cross Section Tables

5.2.4 Design of Flat Plates Based on the Results of Finite Element
Analysis  (The DESIGN SLAB Command)

5.2.5 ISO 19902:2007(E) code for fixed steel offshore structure.

5.2.6 ASCE4805 Steel Design Code.  This code is for the ultimate
strength design of steel transmission pole structures.
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5.3 Analysis Prerelease Features

5.3.1 Calculate Error Estimate Command

5.4 General Prerelease Features

5.4.1 Rotate Load Command

5.4.2 Reference Coordinate System Command

5.4.3 GTMenu Point Coordinates and Line Incidences Commands

We encourage you to experiment with these prerelease features and provide us with
suggestions to improve these features as well as other GTSTRUDL capabilities.
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5.2 Design Prerelease Features

5.2.1 LRFD3 Steel Design Code

The LRFD3 code is primarily based on the AISC “Load and Resistance Factor
Design Specification for Structural Steel Buildings” adopted December 27, 1999 with
errata incorporated as of September 4, 2001.  The Specification is contained in the Third
Edition of the AISC Manual of Steel Construction, Load and Resistance Factor Design
(96).  The LRFD3 code utilizes the Load and Resistance Factor design techniques of the
AISC Specification.  Rather than use the LRFD3 code which is a prerelease feature, users
should use the AISC13 code which is now a released feature.

The LRFD3 code of GTSTRUDL may be used to select or check any of the
following shapes:

Design for bi-axial bending and axial forces:

I shapes Round Bars
Channels Square Bars
Single Angles Rectangular Bars
Tees Plate Girders
Double Angles

Design for bi-axial bending, axial, and torsional forces:

Round HSS (Pipes)
Rectangular and Square HSS (Structural Tubes)

The documentation for the LRFD3 code may be found by selecting Help and then
Reference Documentation, Reference Manuals, Steel Design, and LRFD3 in the
GTSTRUDL Output Window.
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5.2.2 ACI Code 318-99

Design of beams and columns by the 1999 ACI code has been added.  Only
members designated as TYPE BEAM or TYPE COLUMN in a DESIGN DATA
command can be PROPORTIONed when the METHOD is set to ACI318-99.  When you
specify ACI318-99, you will be reminded that it is a pre-release feature by a message
(see the Example below).  
Note that CHECK is not available for codes after ACI318-77, including ACI318-99.

Example:

METHOD ACI318-99
   ****INFO_MET – 318-99 is a pre-release feature.

DESIGN DATA FOR MEMBER 1
   TYPE BEAM RECT
PROPORTION MEMBER 1

....
ACTIVE CODE  =  ACI 318-99

....
(the rest of the output is the same format as previous codes)
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The table of CONSTANTS and assumed values for ACI 318-99 is shown below:

TABLE 2.4-1.  CONSTANTS and Assumed Values for ACI 318-99
CONSTANT Explanation ACI 

318-99
Assumed Value

FCP Compressive strength of concrete, f'c 4000 psi  

FY Yield strength of reinforcement, fy 60000 psi  

WC Unit weight of plain concrete 145 pcf  

DENSITY Unit weight of reinforced concrete (1) 150 pcf  

FC Allow compr. stress in concrete, Fc A.3.1           0.45(FCP)  

VU Ult. shear stress in beam with web reinf. (2) 11.5.6.9
(5)

V Allow. shear stress in beam with web reinf. A.3.1(b)

RFSP Splitting ratio, fct/              (3) 9.5.2.3 6.7  

FYST Yield strength of stirrups 60000 psi  

FYSP Yield strength of spiral 60000 psi  

FS Allowable tension stress in primary reinf. 20000 psi for  

FSC Allowable compressive stress in column reinf. (4) A.3.2 Grades 40, 50  

FV Allowable tension stress in stirrups (5) 24000 psi for  

Grade 60  

PHIFL Flexure  capacity reduction factor 9.3.2 0.9  

PHISH Shear  capacity reduction factor 9.3.2 0.85  

PHIBO Bond  capacity reduction factor 9.3.2 0.85  

PHITO Torsion  capacity reduction factor 9.3.2 0.85  

PHISP Spiral column  capacity reduction factor 9.3.2 0.75  

PHITI Tied column  capacity reduction factor 9.3.2 0.7  

BLFR Ratio of max p, (p - p') or (pw - pf) to pbal 10.3.3 0.75  

PMAXCO Maximum allowable reinforced ratio in columns 10.9.1 0.08  

PMINCO Minimum allowable reinforced ratio in columns 10.9.1 0.01  

PMINFL Minimum allowable reinforced ratio in flexural
members

10.5.1 200/FY  

ES Modulus of elasticity for reinf. steel 8.5.2 29x106psi  

EC Modulus of elasticity for concrete 8.5.1     33(WC)1.5  

EU Ult. strain in concrete at extreme comp. fiber 10.2.3 0.003  
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Notes:

1. The constant 'DENSITY' is the GTSTRUDL constant of the same name
which has been set to a value of 150 pcf for reinforced concrete.

2. VU is multiplied by PHISH internally.

3. Calculations for Vc and Tc are modified by replacing         with 
(RFSP/6.70)      as per Section 11.2.1.1.

4. The assumed value of FSC is also limited to 30,000 psi maximum.

5. This value is defined only at the time of stirrup design.
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5.2.3 Rectangular and Circular Concrete Cross-Section Tables

New tables have been added for rectangular and circular concrete cross sections. 
The new table for rectangular sections is called CONRECT and the new table for circular
sections is called CONCIR.  These tables are added to facilitate the modeling and
analysis of concrete cross sections but may not be used in the design of concrete cross
sections.  In order to design concrete sections, the MEMBER DIMENSION command
must be used (see Section 2.5 of Volume 4 of the GTSTRUDL User Reference Manual).

The profiles in the CONCIR table are shown below where the name CIRxx
indicates a circular cross section and xx is the diameter in inches.  Thus, CIR12 is a 12
inch diameter circular cross section.

CIR12 CIR24
CIR14 CIR26
CIR16 CIR28
CIR18 CIR30
CIR20 CIR32
CIR22 CIR34

CIR36

The profiles in the CONRECT table are shown below where the name RECYYXZZ
indicates a rectangular cross section with a width of YY inches and a depth of ZZ inches. 
Thus, REC16X24 is 16 inch wide and 24 inch deep rectangular cross section.

REC6X12 REC8X12 REC10X12 REC12X12 REC14X12 REC16X12

REC6X14 REC8X14 REC10X14 REC12X14 REC14X14 REC16X14

REC6X16 REC8X16 REC10X16 REC12X16 REC14X16 REC16X16

REC6X18 REC8X18 REC10X18 REC12X18 REC14X18 REC16X18

REC6X20 REC8X20 REC10X20 REC12X20 REC14X20 REC16X20

REC6X22 REC8X22 REC10X22 REC12X22 REC14X22 REC16X22

REC6X24 REC8X24 REC10X24 REC12X24 REC14X24 REC16X24

REC6X26 REC8X26 REC10X26 REC12X26 REC14X26 REC16X26

REC6X28 REC8X28 REC10X28 REC12X28 REC14X28 REC16X28

REC6X30 REC8X30 REC10X30 REC12X30 REC14X30 REC16X30

REC6X32 REC8X32 REC10X32 REC12X32 REC14X32 REC16X32

REC6X34 REC8X34 REC10X34 REC12X34 REC14X34 REC16X34

REC6X36 REC8X36 REC10X36 REC12X36 REC14X36 REC16X36
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REC18X12 REC20X12 REC22X12 REC24X12 REC26X12 REC28X12

REC18X14 REC20X14 REC22X14 REC24X14 REC26X14 REC28X14

REC18X16 REC20X16 REC22X16 REC24X16 REC26X16 REC28X16

REC18X18 REC20X18 REC22X18 REC24X18 REC26X18 REC28X18

REC18X20 REC20X20 REC22X20 REC24X20 REC26X20 REC28X20

REC18X22 REC20X22 REC22X22 REC24X22 REC26X22 REC28X22

REC18X24 REC20X24 REC22X24 REC24X24 REC26X24 REC28X24

REC18X26 REC20X26 REC22X26 REC24X26 REC26X26 REC28X26

REC18X28 REC20X28 REC22X28 REC24X28 REC26X28 REC28X28

REC18X30 REC20X30 REC22X30 REC24X30 REC26X30 REC28X30

REC18X32 REC20X32 REC22X32 REC24X32 REC26X32 REC28X32

REC18X34 REC20X34 REC22X34 REC24X34 REC26X34 REC28X34

REC18X36 REC20X36 REC22X36 REC24X36 REC26X36 REC28X36

REC30X12 REC32X12 REC34X12 REC36X12

REC30X14 REC32X14 REC34X14 REC36X14

REC30X16 REC32X16 REC34X16 REC36X16

REC30X18 REC32X18 REC34X18 REC36X18

REC30X20 REC32X20 REC34X20 REC36X20

REC30X22 REC32X22 REC34X22 REC36X22

REC30X24 REC32X24 REC34X24 REC36X24

REC30X26 REC32X26 REC34X26 REC36X26

REC30X28 REC32X28 REC34X28 REC36X28

REC30X30 REC32X30 REC34X30 REC36X30

REC30X32 REC32X32 REC34X32 REC36X32

REC30X34 REC32X34 REC34X34 REC36X34

REC30X36 REC32X36 REC34X36 REC36X36
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5.2.4 Design of Flat Plates Based on the Results of Finite Element
Analysis  (The DESIGN SLAB Command)

The goal of the DESIGN SLAB command is to select reinforcing steel for
concrete flat plate systems using finite elements as a tool for the determination of design
moments. 

Instead of dealing with results on an element-by-element basis, the user will be
able to design the reinforcing steel for slab systems based on cuts.  Here, the term cut
refers to the cross-section of a strip at a particular location to be designed.  A cut is
defined by two nodes identifying the start and end of the cut, and by an element in the
plane of the cut.  

Once the definition of the cut has been determined, the resultant forces along the
cut are computed using either moment resultants (otherwise known as the Wood and
Armer method) or element force results (using the CALCULATE RESULTANT
command, as described in Section 2.3.7.3 of Volume 3 of the Reference Manuals).  The
final design moment is determined by computing the resultant moment acting on the cut
for each loading condition, and reducing these moments to a design envelope.  

Once the design envelope is computed, the cross-section is designed according to
ACI 318-05 either using default design parameter or with certain user specified design
parameters such as the bar size or spacing.

An important distinction is to note that each cut is designed independently from
all other cuts.  That is, a cut specified in one region is independent with respect to a
design in another region.  As such, if the user wishes to use the same bar size over
multiple adjacent cuts, this information must be specified for each cut. 
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DESIGN SLAB (REINFORCEMENT) (USING) 

WOOD (AND) (ARMER)
AVERAGE

    MAXIMUM
CALCULATE (RESULTANT) (ELEMENT) (FORCES)

 (ALONG) 

(CUT 
'a'
i ) 

JOINTS
NODES  list  ELEMENT list  (TABLE 

ASTM
    UNESCO

TOP (FACE) (BARS i ) (SPACING v )
BOTTOM (FACE) (BARS i ) (SPACING v )
BOTH (FACES) (BARS i ) (SPACING v )

1
1 2

*

2 1

3 2

4 3

−
→⎧

⎨
⎩

⎫
⎬
⎭

⎧
⎨
⎪

⎩⎪

⎫
⎬
⎪

⎭⎪
−

⎧
⎨
⎩

⎫
⎬
⎭

⎧
⎨
⎩

⎫
⎬
⎭

→⎧
⎨
⎩

⎫
⎬
⎭
−

⎧
⎨
⎪

⎩⎪

⎫

)

⎬
⎪

⎭⎪
−

→⎧
⎨
⎩

⎫
⎬
⎭

−
INNER (LAYER)

   OUTER (LAYER)  (COVER v ) (LINEAR (TOLERANCE) v ) 

(TORSIONAL (MOMENT) (WARNING) v )

4 5

6

The form of the command is as follows:  

where,

‘a’ or i1 refer to an optional alphanumeric or integer cut name

list1 = list containing ID’s of the start and end node of the cut
list2 = list containing the ID of an element in the plane of the cut
i2 = bar size to be used for bars on the top surface of the slab
i3 = bar size to be used for bars on the bottom surface of the slab
i4 = bar size to be used for both the top and bottom surfaces of the

slab
v1 = reinforcing bar spacing to be used on the top surface of the slab
v2 = reinforcing bar spacing to be used on the bottom surface of the

slab
v3 = reinforcing bar spacing to be used on both surfaces of the slab
v4 = optional user-specified cover distance for reinforcing bars
v5 = linear tolerance used in element selection rules for moment

computation
v6 = optional ratio of torsion to bending moment allowed on the

cross-section
TOP = element surface with +Z PLANAR coordinate
BOTTOM = element surface with -Z PLANAR coordinate
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Explanation:

The DESIGN SLAB command allows the user to communicate all data necessary
for the reinforcing steel design.  This information is processed and a design is calculated
based on the input.  The command is designed to provide varying levels of control for the
user so as to make the command as broadly applicable as possible.  

The user must first define the cut.  A cut is defined by a start and end node ID,
and an element ID in the plane of the cut.  The user has the option of giving each cut an
alphanumeric name for organizational purposes.  The purpose of the required element ID
is to determine the appropriate plane to design in the event that multiple planes of finite
elements intersect along the cut, as defined by the start and end node.  An example where
this might occur is the intersection of a slab with a shear wall.  In this case, a misleading
design could be generated if the slab was designed using the forces in the shear wall.  The
cut definition constitutes all information required to compute the resultant forces acting
along the cut.

The total moment acting on a cut cross-section is computed using one of two
methods.  The use of moment resultants, also known as the Wood and Armer method, is
implemented as the default method.  In this method, the moment resultants MXX, MYY,
and MXY are resolved on a per node basis along the cut, and either the average effect or
the maximum effect on the cut is applied to the entire cross-section.

The other option for moment computation is based on the use of element forces. 
In this method, the total resultant moment acting on the cross-section is computed using
the CALCULATE RESULTANT command, and the element force nodal moments are
resolved for each node of each element adjacent to the cut.  

Once the cut has been defined, the user may indicate parameters to be used to
design the system.  The user may constrain the bar size or spacing to a certain value,
either for the top face, bottom face, or for both faces.  In this case, the final design will
utilize the information provided.  If the bar size is constrained, the appropriate spacing of
bars is determined.  If the bar spacing is constrained, the appropriate bar size is
determined.  In the case that the user supplies a bar size and spacing for the cut, the
application will simply check the strength of the cross-section against the computed
design envelope according to ACI 318.  If the user specifies no design constraints, the
application assumes a bar size and designs the section to satisfy ACI 318.  As such, the
user maintains explicit control over the function of the application.

The user may also specify which layer of bars to be designed, using the modifier
INNER or OUTER.  These refer to the location of reinforcing bars on each surface.  At
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most slab locations, reinforcement is placed in two perpendicular directions on both
surfaces of the slab.  Since each layer of reinforcement cannot occupy the same space,
one layer must be placed on top of the other.  OUTER refers to the layer closest to the
surface, while INNER refers to the layer nearest the center of the slab.  

All user-specified constraints, such as concrete compressive strength, yield
strength, cover, and spacing are checked against ACI minimum/maximum values, as
specified in ACI 318-02.  The thickness of the cross-section is determined internally
based on the modeled thickness of the user-specified element.

With respect to the interpretation of results, “top” always refers to the face of the
slab on the +Z PLANAR side of the element, and “bottom” always refers to the face of
the slab on the -Z PLANAR side of the element.  “Positive bending” refers to bending
that produces tension on the bottom face of the slab and compression on the top face, as
defined previously.  “Negative bending” produces tension on the top face and
compression on the bottom face, as defined previously.

Requirements:

The MATERIAL REINFORCED CONCRETE command must be specified
before the DESIGN SLAB.  The MATERIAL REINFORCED CONCRETE command
initializes the RC capabilities of GT STRUDL and sets the relevant material and design
quantities to their default values for design.  At this point, the user can issue the
CONSTANTS command to modify any material properties to be used in the design.  The
default values are:

ECU = 0.003

ES = 29,000,000 psi

FCP = 4000 psi

FY = 60,000 psi

PHIFL = 0.9

The STIFFNESS command must be issued prior to the DESIGN SLAB
command.  The STIFFNESS command solves the global equilibrium equation and
computes the quantities required for the determination of the bending moments that the
DESIGN SLAB command uses.
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Only elements known to appropriately model the behavior of slab systems are
included in the computation of design forces.  For a flat plate system, only plate bending
and plate elements are used.  Thus, if the user models the system using plane stress /
plane strain elements, and then issues the DESIGN SLAB command, a warning message
is output and the command is ignored.

Plate bending elements supported include the BPHT, BPR, BPHQ, CPT, and
IPBQQ finite elements.  General plate elements supported include the SBCT, SBCR,
SBHQ, SBHQCSH, SBHT, SBHT6, and SBHQ6 finite elements.

Usage:

Studies have shown that the CALCULATE RESULTANT ELEMENT FORCE
option of the DESIGN SLAB command is only applicable in regions where the cut
orientation is generally orthogonal to the directions of principle bending.  If the geometry
of a region dictates that a cut be oriented non-orthogonally to the principal bending
directions, a significant torsional effect may occur.  In this case, the Wood and Armer
method must be employed due to its ability to correctly compute the ultimate moment in
a strong torsion field.  In the DESIGN SLAB command, the user is warned if the element
force implementation computes a resultant torsion greater than 10% of the resultant
bending moment on a particular cross-section.  The user may modify the torsion warning
threshold via the modifiers TORSIONAL MOMENT WARNING.  If there is any
question of the orientation of the cut with respect to the directions of principal bending,
the user should investigate the behavior in the finite element results section of GTMENU.
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Usage Example:  Description of Example Structure

The example structure is a rectangular slab system, shown in Figure 5.2.4-1.  The clear
span of the structure is thirty feet, and the slab strip has a width of ten feet.  The two ends
of the slab are fully fixed, while the thirty foot sides are free, resembling a fixed-fixed
beam.  The slab is one foot thick and constructed of normal strength concrete with FCP =
4000 psi.  The example structure can be idealized as a subset of a larger slab system,
perhaps the design strip running between two column faces in an interior region.  The
structure is loaded with a distributed surface pressure of 150 psf over the entire surface of
the slab.

Figure 5.2.4-1    Example Flat Plate Structure (PLAN)
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GT STRUDL Finite Element Model

The example structure was modeled in GT STRUDL using PLATE BENDING finite
elements.  The BPHQ element was utilized, and the configuration modeled corresponded to
a mesh of ten elements by thirty elements.  The model contained 300 finite elements and 341
nodes.  The material properties were the default values associated with the MATERIAL
REINFORCED CONCRETE command.  All 6 degrees of freedom were restrained at each
node along the supported ends of the slab system.  Each element was loaded with a surface
pressure of 150 psf, resulting in a confirmed summation of vertical reaction of 45,000 lb.
 

Figure 5.2.4-2    Example Finite Element Model

Definition of Cut Cross-Sections

Two “cuts” are considered for the verification example, as shown in Figure 5.2.4-1.

Cut 1-1:

The cross-section Cut 1-1 is defined along the fixed support at the end of the slab strip and
represents the maximum “negative moment” section in the slab where top reinforcing steel
would be required.  Cut 1-1 originates at node #1 and terminates at node #11.  The elements
along Cut 1-1 are elements #1-#10.  The command given for Cut 1-1 is:

“DESIGN SLAB USING CALCULATE RESULTANT JOI 1 11 ELE 1 TOP BAR 5"
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In this case, the user requests that a slab cross-section beginning at node #1, ending at node
#11, and in the plane of element #1 be reinforced according to the section moment computed
using the CALCULATE RESULTANT command.  The user has specified that #5 bars are
to be used on the top surface, indicating that spacing is to be computed.  The results of the
DESIGN SLAB command are shown in the following table.

Calculation Surface Bar Spacing Area Prov. Moment Strength Moment Required

# in sq. in. lb-in lb-in

DESIGN SLAB Top 5 13.0 2.862 1561006.4 1354381.5

DESIGN SLAB Bottom NA NA NA NA NA

The GTSTRUDL output for this example is as follows:

  ** FLAT PLATE SLAB DESIGN BASED ON THE RESULTS OF FINITE ELEMENT ANALYSIS **

       PROBLEM - VFE103    TITLE - DESIGN SLAB VERIFICATION - VERIFY DESIGN CALCULATIONS  
       

       RELEVANT ACTIVE UNITS:  INCH LB  

       NUMBER OF ACTIVE LOADINGS:     1

       REINFORCEMENT ORIENTATION PERPENDICULAR TO A CUT BEGINNING AT NODE 1       
         AND TERMINATING AT NODE 11       AND IN THE PLANE OF ELEMENT 1       

 
  ** ELEMENT FORCE IMPLEMENTATION **
 

  ** DESIGN MOMENT ENVELOPE **

       NEGATIVE MOMENT =      -1354381.48   DUE TO LOAD   150psf  
       POSITIVE MOMENT =             0.00   DUE TO LOAD   (none)  

       NOTE:
- Negative moment produces tension on the positive PLANAR Z surface, requiring TOP
bars.

- Positive moment produces compression on the positive PLANAR Z surface, requiring
BOTTOM bars.

  ** SLAB CROSS-SECTION **

       Width        Depth          FCP           FY        Cover        Layer
      ________________________________________________________________________

      120.00       12.00        4000.00       60000.00     0.750        Inner

  ** DESIGN RESULTS (per ACI 318-05) **

       Face       Bar    Spacing   AS PROV'D    MOMENT STRENGTH    MOMENT REQ'D    STATUS
    
_________________________________________________________________________________________

       TOP        # 5    13.000      2.862        1561006.4280    1354381.4844     PASSES

       BOTTOM             ( Reinforcement Not Required )
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Cut 2-2:

The cross-section Cut 2-2 is defined along the center line in the middle region of the slab
strip and represents the maximum “positive moment” section in the slab where bottom
reinforcing steel would be required.  Cut 2-2 originates at node #166 and terminates at node
#176.  The elements along Cut 2-2 are elements #141-#150 on one side and #151-#160 on
the other side.  The command given for Cut 2-2 Case 1 is:

“DESIGN SLAB WOOD AND ARMER JOI 166 176 ELE 141 TABLE UNESCO
BOTTOM SPACING 10 OUTER LAYER"  

In this case, the user requests that a slab cross-section beginning at node #166, ending at
node #176, and in the plane of element #141 be reinforced according to the average effect
produced by the Wood and Armer method.  The user has specified that UNESCO metric
reinforcing bars are to be used.  The bottom reinforcement spacing has been constrained to
10 inches, and the reinforcement to be designed is located in the outer layer.  The results of
the DESIGN SLAB command are shown in the following table:

Calculation Surface Bar Spacing Area Prov. Moment Strength Moment Required

# in sq. in. lb-in lb-in

DESIGN SLAB Bottom M14 10.0 2.864 1664920.7 671358.2

DESIGN SLAB Top NA NA NA NA NA
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The GTSTRUDL output for this example is as follows:

  ** FLAT PLATE SLAB DESIGN BASED ON THE RESULTS OF FINITE ELEMENT ANALYSIS **

       PROBLEM - VFE103    TITLE - DESIGN SLAB VERIFICATION - VERIFY DESIGN CALCULATIONS  
       

       RELEVANT ACTIVE UNITS:  INCH LB  

       NUMBER OF ACTIVE LOADINGS:     1

       REINFORCEMENT ORIENTATION PERPENDICULAR TO A CUT BEGINNING AT NODE 166     
         AND TERMINATING AT NODE 176      AND IN THE PLANE OF ELEMENT 141     

  ** WOOD & ARMER IMPLEMENTATION **

       Design using average result acting on section.

  ** DESIGN MOMENT ENVELOPE **

       NEGATIVE MOMENT =             0.00   DUE TO LOAD   150psf  
       POSITIVE MOMENT =        671358.19   DUE TO LOAD   150psf  

NOTE:
       - Negative moment produces tension on the positive PLANAR Z surface, requiring TOP
bars.
       - Positive moment produces compression on the positive PLANAR Z surface, requiring
BOTTOM bars.

  ** SLAB CROSS-SECTION **

       Width        Depth          FCP           FY        Cover        Layer
      ________________________________________________________________________

      120.00       12.00        4000.00       60000.00     0.750        Outer

  ** DESIGN RESULTS (per ACI 318-05) **

       Face       Bar    Spacing   AS PROV'D    MOMENT STRENGTH    MOMENT REQ'D    STATUS
    
_________________________________________________________________________________________

       TOP                ( Reinforcement Not Required )

       BOTTOM     M14    10.000      2.864        1664920.7190     671358.1875     PASSES
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5.2.5 ISO 19902:2007 Code for the Design of Fixed Steel Offshore
Structures

A new International Standard ISO 19902:2007(E), First Edition, 2007-12-01, Petroleum
and natural gas industries – Fixed steel offshore structures has been implemented as a
prerelease feature.  The GTSTRUDL code name for this new offshore code is “19902-07”.
The 19902-07 code performs Basic, Hydrostatic Pressure, and Punching Shear stresses
check according to International Standard ISO 19902:2007(E).  This new code, 19902-07,
may be used to select or check Circular Hollow Sections (Pipes).  The prerelease
documentation for the 19902-07 code may be found by selecting the help menu and then
Reference Documentation, Reference Manuals, Offshore Loading, Analysis and Design, and
19902-07: ISO 19902:2007(E), First Edition in the GTSTRUDL Output Window.
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5.2.6 ASCE4805 Code for the Design of Steel Transmission Pole
Structures

The steel design code, ASCE4805, which is based on the 2005 edition of the ASCE/SEI,
Design of Steel Transmission Pole Structures Specification has been implemented as a pre-
release feature.  The ASCE/SEI 48-05 Specification is based on ultimate strength methods
using factored loads. 

The ASCE4805 Code may be used to select or check any of the following shapes:

Design for axial force, bi-axial bending, and torsion:

Pipes

Regular Polygonal Tubes

Structural Tubing 

The documentation for the ASCE4805 code may be found by selecting the Help menu  and
then Reference Documentation, Reference Manuals, Steel Design, and “ASCE4805" in the
GTSTRUDL Output Window.
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5.3 Analysis Prerelease Features

5.3.1 The CALCULATE ERROR ESTIMATE Command 

The form of the command is as follows:

CALCULATE ERROR (ESTIMATE) (BASED ON)   -

*

*

The results from this command provide an estimate of the errors in the finite element
discretization of the problem.  Energy norm (L2 norm) and nodal error estimates are available.

The L2 norm is given by:

( ) ( )
L2

1/2
T

e  = e  e dσ σ σ
Ω

⎛ ⎞
Ω⎜ ⎟

⎝ ⎠
∫

where       is the error in stress and  is the domain of the element.  The error stresseσ
Ω

is the difference between the average stress, , and element stress at the nodes, .σ * σ
The stress norm is obtained by using the shape functions used for displacements, thus,

where N is the shape functions used for the assumed displacement field of the element.
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The stress norm uses the average stresses and is given by:

The relative percentage error which is output for each element is given by:
The nodal error estimates estimate the accuracy of the data in a selected nodal output vector.

Six nodal error estimation methods are available:

C Maximum Difference.

C Difference from Average.

C Percent Maximum Difference.

C Percent Difference from Average.

C Normalized Percent Maximum Difference.

C Normalized percent Difference from Average.

These error estimates look at the variations in stresses at the nodes.  An error estimate
of nodal output data will be based on the gradients that data produces in each element.  That
is, how the data varies across that node based on the different data values from the elements
connected at that node.  The calculation of error estimates for nodal output is fairly
straightforward, the values at each node connected at an element are simply compared.  The
six nodal error measures are outlined in more detail below:
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Value  -  Value
Value

  100%Max Min

Avg
×

( )MAX  Value  -   Value  Value  -   Value  

 Value  
 100%

Max Avg Min Avg

Avg

,
×

Value  -  Value
Value

  100%Max Min

VectorMax
×

( )MAX  Value  -   Value  Value  -   Value  

 Value  
 100%

Max Avg Min Avg

VectorMax

,
×

Maximum Difference Method

Difference from Average Method

Percent Maximum Difference Method

Percent Difference from Average Method
Normalized Percent Maximum Difference

Normalized Percent Difference from Average Method

In each of these calculations, the “Min”, “Max”, and “Avg” values refer to the
minimum, maximum, and average output values at the node.  The “Vector Max” values refer
to the maximum value for all nodes in the output vector.  All error estimates are either zero or
positive, since all use the absolute value of the various factors.



Analysis Prerelease Features GT STRUDL

5.3 - 4

The choice of an appropriate error estimation method largely depends on the conditions
in the model.  As many error estimates as required may be calculated.  In general, the Max
Difference method is good at pointing out the largest gradients in the portions of your model
with the largest output values.  The Difference from Average Method will also identify areas
with the largest output values.  In this case however, areas where only one or a few values are
significantly different will be accentuated.  The Max Difference method will identify the
steepest gradients in the most critical portions of your model.  The Difference from Average
Method will identify just the steepest non-uniform gradients, the ones that vary in only a single
direction.  The two percentage methods identify the same type of gradients, but do not make
any distinction between large and small output values.  These methods are to be used only if
the magnitude of the output is less important than the changes in output.  The two percentage
methods estimate the error as a percent of the average stress.  However, at nodes where there
is a change in sign of the stress, the average stress becomes very small and often close to zero.
As a result, the value of the error becomes enormous.  In order to quantify this error, the error
at such nodes is given a value of 1,000 percent.  The final two normalized percentage methods
are usually the best at quantifying overall errors in area with peak stress values.

The results produced by the CALCULATE ERROR ESTIMATE command may also
be contoured in GTMenu.  To produce a contour of the error estimate in GTMenu, follow the
steps below after performing a STIFFNESS ANALYSIS for a static loading:

1. Enter GTMenu.

2. Select Results, Finite Element Contours, and then Energy & Stress Error
Estimates.

3. Select the Estimate Method including Value, Surface, and Stress Component.

4. Select the Loading.

5. Select Display (solid colors or lines) to produce a contour of the error estimate.

6. Select Legend to place a legend on the screen indicating the type of error
estimate, loading, and surface.
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5.4 General Prerelease Features

5.4.1 ROTATE LOAD Command

The ROTATE LOAD command will rotate an existing loading and create a new
loading condition in order to model a different orientation of the structure or the loading.  The
ROTATE command is described below and is numbered as it will appear when added to
Volume 1 of the GTSTRUDL User Reference Manual.

2.1.11.4.6 The ROTATE LOAD Command

General form:

Elements:

iR/’aR’ = integer or alphanumeric name of the existing independent loading
condition whose global components are to be rotated.

r1, r2, r3 = values in current angle units of the load component rotation angles 21,
22, 23 as shown in Figure 2.1.7-1, Volume 1, GTSTRUDL User
Reference Manual.

Explanation:

In many instances, loading conditions are defined for a structure having a given
orientation in space, but then the same structure may need to be analyzed for different
additional orientations.  Applied loading components that are defined with respect to
local member or element coordinate systems remain unchanged regardless of the
structure’s orientation.  However, loading components that are defined with respect to
the global coordinate system may need to be rotated in order to properly reflect a new
orientation for the structure.  This is particularly true for self-weight loads, buoyancy
loads, etc.
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The ROTATE LOADING command is used to take the global applied loading
components from an existing loading condition, rotate them through a set of rotation
angles, and copy the new rotated global components to a new or modified different
destination loading condition.  The existing independent loading condition, the
ROTATE load, from which the rotated global load components are computed is
specified by the loading name iR/’aR’.  The angles of rotation are specified by the
values r1, r2, r3.  These rotation angles are defined according to the same conventions
as those that define the local support release directions in the JOINT RELEASE
command described in Section 2.1.7.2, Volume 1 of the GTSTRUDL User Reference
Manual, and illustrated in Figure 2.1.7-1.

The ROTATE LOADING command is always used in conjunction with one of the
following loading definition commands: LOADING, DEAD LOAD, and FORM
LOAD.  These commands will define the name (and title) of a new or existing
destination loading condition into which the ROTATE LOADING results are copied.
The ROTATE LOADING command may be given with any additional applied loading
commands such as JOINT LOADS, MEMBER LOADS, ELEMENT LOADS, etc.  

Taking the specified loading iR/’aR’, the ROTATE LOADING  command performs the
following operations and copies the results into the destination loading condition:

1. Rotate all joint loads, including applied joint support displacements.

2. Rotate all member force and moment loads defined with respect to the
global coordinate system.  Member force and moment loads defined
with respect to the member local coordinate system are simply copied
without rotation.

3. Rotate all element force loads defined with respect to the global
coordinate system.  Element force loads defined with respect to any
applicable local or planar coordinate systems are copied without
rotation.

4. All other types of loads such as member temperature loads, member
distortions, joint temperatures, etc. are copied without changes.
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Examples:

1. UNITS DEGREES
LOADING 2 ‘ROTATED LOADING’
MEMBER DISTORTIONS

1 TO 10 UNIFORM FR LA 0.0 LB 1.0 DISPL X 0.001
ROTATE LOADING 1 ANGLES T1 45.0

The applied loads from previously defined loading 1 will be processed according to
Steps 1 to 4 above and copied into the new destination loading 2, which includes the
specified member distortion loads applied to members 1  to  10.

2. UNITS DEGREES
CHANGES
LOADING 3
ADDITIONS
ROTATE LOAD 4 ANGLES T2 -30.0

Previously defined loading 3 is specified in CHANGES mode, followed by a return to
ADDITIONS mode.  The ROTATE LOAD command is then given to add the
components of load 4, including appropriate rotations, to loading 3.

Error Messages:

Incorrect data given in the ROTATE LOADING command will cause the following
error conditions to be identified and error messages printed:

1. The following error message is printed if the ROTATE loading name is identical to the
name of the destination load.  An example of the commands that produce this error are
also included:

{   114} > LOADING 201
{   115} > ROTATE LOAD 201 T1 45.0

**** ERROR_STROLO – The ROTATE loading is illegally the same as the
destination loading.
Command ignored.

Loading 201 is illegally named as both the destination load and the loading whose
components are rotated.
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2. In the following error example, loading 51 is undefined.

{   111} > LOADING 201
{   112} > ROTATE LOAD 51 T1 45.0

**** ERROR_STROLO – Loading to be rotated undefined.
Command ignored.

3. The following error message is produced because loading 4, specified as the ROTATE
load, is a load combination, or dependent loading condition.  The ROTATE load must
be an independent loading condition.

{   141} > LOADING 108
{   142} > ROTATE LOADING 4 T3 45.0

**** ERROR_STROLO – Rotated Loading 4 is an illegal dependent load.
Command ignored.

4. This error condition and message is caused by the fact that the destination load 108 is
defined as a loading combination.

{   144} > LOAD COMB 108 ‘ALL’ COMBINE 1 1.5 2 1.0 3 1.0
{   145} > ROTATE LOADING  1 T3 45.0

**** ERROR_STROLO – Destination independent loading not defined.
Rotated load components not computed.
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5.4.2     Reference Coordinate System Command

General form:

 

Explanation:

The REFERENCE COORDINATE SYSTEM is a right-handed three-dimensional
Cartesian coordinate system.  The Reference Coordinate System’s origin may be
shifted from the origin (X=0.0, Y=0.0, Z=0.0) of the overall global coordinate
system.  The Reference Coordinate System axes may also be rotated from the
corresponding orthogonal axes of the overall global coordinate system.

At the present time, this command is used to specify additional coordinate systems
which may be used in GTMenu (see Volume 2 of the GTSTRUDL Release Guide)
to facilitate the creation of the structural model.  Reference Coordinate systems
created using the above command will be available as Local systems in GTMenu.
In a future release, the user will be able to output results such as joint displacements
and reactions in a Reference Coordinate System. 

There are two optional means of specifying a Reference Coordinate System: 

(1) Define the origin and rotation of coordinate axes of the reference system with
respect to the global coordinate system, and 

(2) define three joints or the coordinates of three points in space.

In either case, i1 or ‘a1’ is the integer or alphanumeric identifier of the reference
coordinate system.  For the first option, vx, vy, and vz are the magnitude of
translations in active length units of the origin of this system from the origin of the
overall global coordinate system.  The translations vx, vy, and vz, are measured
parallel to the orthogonal axes X, Y, and Z, respectively, of the global system and
are positive in the positive directions of these axes; v1, v2, and v3 are the rotation
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angles R1, R2, and R3 in active angular units between the orthogonal axes of this
system and the axes of the overall global coordinate system.  The description of these
angles is the same as given in Section 2.1.7.2 of Volume 1 of the GTSTRUDL User
Reference Manuals for rotated joint releases (21, 22, and 23).

In the second case, three joints are required.  Each of the three joints may be defined
either by a joint identifier using the JOINT option of the command or by its global
X, Y, and Z coordinates.  If the joint identifier option is used, however, the
coordinates of the joint must be specified previously by the JOINT COORDINATES
command.  The first time (i2 or ‘a2’ or v4, v5, and v6) defines the origin of the
reference system; the X-axis of the reference system is determined by the first and
second joints (i3 or ‘a3’ or v7, v8, and v9).  The positive X-axis is directed from the
first to the second joint.  The third joint (i4 or ‘a4’ or v10, v11, and v12) is used to define
the XY-plane of the reference system.  The positive Y-axis is directed toward the
third joint.  The Z-axis then is determined by the right-hand rule.

Only one reference system can be specified in one command, but the command may
be used any number of times.

Modifications of Reference Systems:

In the changes mode, the translations of the origin and/or the rotations of the axes of
the reference system from those of the overall global system can be changed.  Only
that information supplied in the command is altered.  The other data that might be
supplied in the command remains unchanged.  The CHANGES mode, however, does
not work for the second option discussed above (i.e., define a reference coordinate
system by three joints or the coordinate of three points in space).  The reason is that
data for these joints are not stored permanently in GTSTRUDL.  When this option
is used, a reference system is created and its definitions of the system origin, rotation
angles, as well as the transformation matrix between the global coordinate system
and the reference system are generated and stored as would be for the first option.
Therefore, if any of the coordinates for the joints used to specify a reference system
is changed after the REFERENCE COORDINATE SYSTEM command has been
given, the definition of the reference system remains unchanged.  For this reason,
care must be taken in using the three joints option in conjunction with the changes
of joint coordinates.  The reference system should be deleted first if any of the
coordinates of the joints used to define the reference system are to be changed.
Under the DELETIONS mode, the complete definition of the reference coordinate
system is destroyed.
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Examples:

a) UNITS DEGREES 
REFERENCE COORDINATE SYSTEM ‘FLOOR2’  -

ORIGIN 0.0 15.0 0.0 R1 30.

This command creates a Reference Coordinate System called FLOOR2 at Y=15 with
the axes rotated 30 degrees about global Z.

b) REF COO 1  -
X    120   Y   120   Z   -120  -
X    120   Y   240   Z        0  -
X   -120   Y   120   Z        0

This command creates Reference Coordinate System 1 with its origin at 120, 120,
-120 and its X-axis from this origin to 120, 240, 0 and its Y axis is the plane defined by the
two previous coordinates and the third coordinate, -120, 120, 0, with the positive Y-axis
directed toward the third coordinate.

c) REFERENCE COORDINATE SYSTEM 2  -
JOINT 10 JOINT 20 JOINT 25

This command creates Reference Coordinate System 2 with its origin located at Joint
10 and its X-axis directed from Joint 10 toward Joint 20.  The XY plane is defined by Joints
10, 20, and 25 with the positive Y-axis directed toward Joint 25.

d) CHANGES
REFERENCE COORDINATE SYSTEM ‘FLOOR2’  -

ORIGIN   10   20   30
ADDITIONS

The above commands change the origin of the Reference System FLOOR2 defined
in a) above.  The rotation RI = 30 remains unchanged.

e) DELETIONS
REFERENCE  SYSTEM 2
ADDITIONS

The above command deletes Reference System 2.
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5.4.2-1 Printing Reference Coordinate System Command

General form:

Explanation:

The PRINT REFERENCE COORDINATE SYSTEM command will output the
Reference Systems.  The origin and rotation angles will be output.

ALL
PRINT REFERENCE (COORDINATE)  (SYSTEM) 

     list
→⎧ ⎫
⎨ ⎬
⎩ ⎭
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5.4.3 GTMenu Point and Line Incidences Commands

GTMenu can now write construction geometry commands to an input file, which can be
read later into GTSTRUDL in order to initialize the construction geometry of GTMenu.  The
two commands written are “GTMenu POINT  COORDINATES” and “GTMenu LINE
INCIDENCES”.

(1) GTMenu POINT COORDINATES

General Form:

GTMenu POINT COORDINATES

         A
         A
         A

Elements:

coordinate-specs = [X] v1 [Y] v2 [Z] v3

Where,

i1, i2, ...,in = unsigned integer Point identifiers.

‘a1', ‘a2', ..., ‘an’ = 1 to 8 character alphanumeric Point identifiers.

v1, v2, v3 = Cartesian Point coordinates (integer or real).
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(2) GTMenu LINE INCIDENCES

General Form:

GTMenu LINE INCIDENCES

         A
         A
         A

Elements:
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Where,

i1, i2, ...,in = unsigned integer Line/Curve identifiers.

‘a1’, ‘a2’, ..., ‘an’ = 1 to 8 character alphanumeric Line/Curve
identifiers.

i1, i2, ..., ip = unsigned integer Point identifiers used.

‘a1’, ‘a2’,  ..., ‘ap’ = 1 to 8 character alphanumeric Point identifiers.

v1 = positive number (integer or real).

k2 = integer between 2 and the number of incidences.

1, 2, ...,p = Point subscripts for a Line/Curve.  The following
table gives the number of Points used to specify
different types of Line/Curve:

type number of incidences

LINE 2 - 500

POLYNOMIAL CURVE 2 - 10

ARC TEMPLATE 3

CENTERED ARC 3

BEZIER CURVE 2 - 10

SPLINE CURVE 2 - 10
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